VMware ESX Server
Virtual Infrastructure Node
Evaluator’s Guide
Datacenter-Class Virtual Infrastructure for Mission-Critical Environments

Installing, Configuring and Evaluating
ESX Server 2.5 and VirtualCenter 1.2

VMware, Inc.
September 2005
# Table of Contents

1. Getting Started .................................................................................................................. 3
2. The IT Challenge Today ....................................................................................................... 5
3. VMware Virtual Infrastructure Introduction ......................................................................... 6
4. VMware Virtual Infrastructure Products ............................................................................... 7
5. VMware Virtual Infrastructure Business Solutions ............................................................. 8
6. ESX Server Overview ........................................................................................................... 9
7. VirtualCenter Overview ....................................................................................................... 12
8. Example Customer Implementations .................................................................................. 14
9. Evaluation Planning & Environment Setup .......................................................................... 16
   9.1 Planning Worksheet ......................................................................................................... 16
   9.2 Overview of the Evaluation Deployment ........................................................................ 20
   9.3 Typical Evaluation Timeline .......................................................................................... 21
   9.4 Hardware Requirements for ESX Server ...................................................................... 22
   9.5 Hardware Requirements for VirtualCenter Management Server .................................. 23
   9.6 Hardware Requirements for Remote Management Workstation ................................ 24
   9.7 Guest Operating Systems Supported .......................................................................... 25
   9.8 Download Product Binaries and Burn to CD-ROM ....................................................... 25
   9.9 Helpful Technical Tips ................................................................................................. 26
10. Installing ESX Server ......................................................................................................... 27
11. Installing VirtualCenter Server & Management Client ...................................................... 38
12. Understanding the Virtual Infrastructure .......................................................................... 43
   12.1 VirtualCenter Manages Virtual Machines Running on Physical Hosts ....................... 43
   12.2 CPU, Memory & Hardware Virtualization .................................................................. 43
   12.3 Storage Virtualization ............................................................................................... 47
   12.4 Network Virtualization ............................................................................................... 48
   12.5 VirtualCenter Software Components ....................................................................... 49
   12.6 VirtualCenter Organizes Servers into Farms and Groups .......................................... 50
   12.7 VirtualCenter Manages Tasks, Templates, Alarms & Events ..................................... 51
   12.8 VirtualCenter Manages Access Privileges with Users & Groups ............................... 52
   12.9 Working with the VirtualCenter Client ...................................................................... 53
   12.10 Common Actions Performed Through VirtualCenter .............................................. 55
13. Creating New Virtual Machines ....................................................................................... 56
   13.1 Creating New Virtual Machines from Scratch .......................................................... 56
   13.2 Creating New Virtual Machines from Existing Servers .............................................. 61
   13.3 Creating, Storing and Deploying Virtual Machine Templates .................................... 62
   13.4 Cloning Virtual Machines .......................................................................................... 75
14. Managing Virtual Machines ............................................................................................... 79
   14.1 Starting, Stopping, Suspending & Resetting Virtual Machines .................................... 79
   14.2 Editing Virtual Machine Configurations ..................................................................... 79
   14.3 Scheduling Tasks ....................................................................................................... 84
   14.4 Using Events & Alarms ............................................................................................. 86
15. Configuring an ESX VIN to use a Storage Area Network .................................................... 87
16. Migrating Virtual Machines across ESX Servers ............................................................... 92
   16.1 Migrate a Powered-Off Virtual Machine to another Host using the SAN ................. 93
   16.2 Migrate a Powered-On Virtual Machine to another Host using the SAN (VMotion) .... 94
17. Application Functional Testing & Load Testing ................................................................. 98
18. Summary ............................................................................................................................ 98
19. Glossary ............................................................................................................................. 99
20. VMware Professional Services .......................................................................................... 102
21. VMware Support Services ............................................................................................... 102
22. VMware Partner Alliance .................................................................................................. 103
23. About VMware .................................................................................................................. 104
1 Getting Started

About This Guide
The purpose of this document is to support a self-guided evaluation of a VMware Virtual Infrastructure Node (VIN) running VMware ESX Server™ 2.5 and managed by VirtualCenter™ 1.2. This document is intended to provide a technical product reviewer with the necessary information to install, manage and evaluate the VMware Virtual Infrastructure.

The content includes a product overview, description of how other customers are using the product, and product installation and usage walkthroughs to demonstrate how easy it is to get started using VMware Virtual Infrastructure. To simplify and minimize initial hardware requirements, this guide first steps through a standard installation to local SCSI disks for a single ESX server managed by VirtualCenter. The guide then continues on with optional activities to demonstrate using multiple ESX Servers with a storage area network (SAN) to support advanced features such as VMotion for the migration of running virtual machines between ESX Server hosts.

This guide attempts in chapters 2-8 to provide contextual background that will assist an evaluator in understanding server virtualization and how the technology can best be applied to drive value in your organization. Those seeking to get started quickly may skip to Chapter 9 to begin the server preparation and installation.

Conventions Used in this Guide
The following conventions are used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Cross references, links</td>
</tr>
<tr>
<td>Courier</td>
<td>Commands, filenames, directories, paths, user input</td>
</tr>
<tr>
<td>Semi-Bold</td>
<td>Interactive interface objects, keys, buttons</td>
</tr>
<tr>
<td>Bold</td>
<td>Items of highlighted interest, terms</td>
</tr>
<tr>
<td>Italic</td>
<td>Variables, parameters</td>
</tr>
<tr>
<td>Italic</td>
<td>Web addresses</td>
</tr>
</tbody>
</table>

Additional Documentation Resources
Although the material presented in this document can all be found on the VMware website, this evaluation guide attempts to bring all the information into a single document to facilitate the evaluation process. Full product documentation on installation and administration is available for download at [http://www.vmware.com/support/pubs/](http://www.vmware.com/support/pubs/).

Evaluation Hardware Requirements
Before starting an evaluation of VMware virtualization software, check the online hardware compatibility lists that are published on the VMware website at [http://www.vmware.com/support/resources/esx_resources.html](http://www.vmware.com/support/resources/esx_resources.html). The compatibility guides will ensure that the hardware that is being considered for the ESX Server evaluation has gone through compatibility testing by VMware.

While the hardware requirements are covered in more detail in section 9.4, a high level summary is provided below:

- An x86 multi-processor server (2 CPU minimum per server) with a SCSI disk for ESX Server installation.
  Two ESX servers are needed along with a SAN to evaluate VMotion migration of virtual machines from one ESX Server to another ESX Server.
- An x86 PC or server with Windows 2000 (or higher) for VirtualCenter Management Server and Client install
- Guest operating systems and applications for testing
- Note that ESX Server requires either a SAN or local SCSI disks for virtual machine storage
Help & Support During the Evaluation
Beyond the available product documentation available at http://www.vmware.com/support/pubs/, the best source for support during an ESX Server evaluation is to refer to the VMware online Knowledge Base available at http://www.vmware.com/support/kb. The Knowledge Base contains hundreds of documented issues and typically offers workarounds or fixes that can help you resolve your issue quickly. This online Knowledge Base is searchable and covers all the products that VMware offers. Other good sources for support include the VMware Community Discussion Forums and the public VMware News Groups.

The VMware Community is a set of moderated discussion forums hosted on the VMware Web site that is open to all VMware users. In the forums, VMware Community members come together to exchange information, ask technical questions and share comments. VMware representatives monitor the forum and respond to questions as appropriate. You can join the community discussion forum at http://www.vmware.com/community.

The VMware Newsgroups are primarily forums for users to help each other. You are encouraged to read and post issues, workarounds and fixes. While VMware personnel may read and post to the newsgroups, this is not a channel for official support. The VMware NNTP news server is at news.vmware.com with additional usage information at http://www.vmware.com/vcommunity/newsgroups.html.

Please note that VMware does not offer technical support on an evaluation basis. When you purchase your product license, you can select the level of technical support that meets your needs. More information about VMware support offerings is available at http://www.vmware.com/support/programs.html.

Providing Feedback
We appreciate your feedback on the material included in this guide. In particular, we would be grateful for any guidance on the following topics:

- How useful was the information in this guide?
- What other specific topics would you like to see covered?
- Overall, how would you rate this guide?

Please send your feedback to the following e-mail address: vin-eval@vmware.com, with "VMware Virtual Infrastructure Node Evaluator’s Guide" in the subject line. Thank you for your help in making this guide a valuable resource.
2 The IT Challenge Today

Today, IT organizations are working diligently to solve the problems created by the explosion in the scope and complexity of IT platforms adopted in the 1990’s. The migration of application architectures to thin-client multi-tier architectures, the introduction of multiple generations and editions of Windows servers and the rapid growth of Linux have swept across IT organizations in successive waves over the last ten years. These waves caused explosive growth in server counts, network complexity and storage volumes throughout geographically distributed IT organizations. The policies and procedures adopted to gain back control of the infrastructure have often introduced their own challenges.

Some of the resulting symptoms reported by IT organizations include:

- Large numbers of under utilized “one-application/one box” x86-based servers
- Pervasive over-provisioning caused by policies that size all servers for “worst-case” workload scenarios
- Long provisioning cycle times for new servers, storage and networking
- Long delays between change request submissions and operational changes
- Narrow scheduled downtime windows that are over-subscribed with maintenance activities
- Inconsistent, non-reproducible server builds due to a lack of build policies or an ability to enforce them
- Rushed patch roll-outs that break application functionality or performance because the patch-testing systems do not match production systems
- Multiple management systems for distributed Linux, Windows and NetWare servers
- Incomplete information for equipment counts, status and ownership

This list of challenges is daunting, but IT has started to regain the upper hand in the battle against costly, inflexible and disorderly infrastructure. As a first step, IT organizations have generally centralized their IT infrastructure into fewer locations for better visibility. As a second step, they are adopting a new generation of infrastructure technologies and methodologies.

The common vision of IT organizations today is to provide their business units with lower cost, higher service-level infrastructure that enables them to respond faster to business unit demands. For example, most enterprises are already migrating to Storage Area Networking for a flexible, lower cost, higher service level storage infrastructure. Currently, thousands of enterprises are adopting server virtualization technologies that provide the same benefits for the rest of the IT infrastructure. This synergistic combination of storage, networking and computing virtualization has created a new category of infrastructure software called virtual infrastructure.
3 VMware Virtual Infrastructure Introduction

Virtual infrastructure provides a layer of abstraction between the computing, storage and networking hardware, and the software that runs on it. Virtual infrastructure introduces a new category of infrastructure capabilities to the data center. With virtual infrastructure, IT organizations can provision new services and change the amount of resources dedicated to a software service simply by interacting with a management console. Hardware management is completely separated from software management, and hardware can be treated as a single pool of processing, storage and networking power – which can be allocated or reallocated to various software services on the fly.

VMware is a pioneer of virtual infrastructure based on virtual machine technology. This technology was originally developed for mainframes to allow multiple operating systems to share a single piece of hardware. VMware pioneered virtual machines on the x86 platform, and has spent more than seven years enhancing their capabilities for general enterprise use. The VMware virtual hardware platform implemented by VMware virtual machines makes virtual infrastructure possible. It provides a standardized hardware image – implemented entirely in software – on which operating systems and applications can run. Whether the underlying hardware is a SAN-attached 8-way system with gigabit Ethernet cards or a direct-attached blade server sharing a network switch, the exact same virtual hardware platform is presented to the operating system and its applications.

The VMware Virtual Hardware Platform

By creating a uniform virtual hardware platform across the entire data center, virtual infrastructure allows software to be installed on or moved from one physical system to another without requiring reconfiguration of the operating system or applications. With groundbreaking VMware VMotion technology, this move is transparent to the user and does not cause an interruption in user service. Adopting virtual infrastructure results in:

- 60-80% utilization rates for x86-based servers - up from today's typical 5-15%
- Just-in-time provisioning of additional resources to applications
- Provisioning times for new applications measured in seconds, not days
- Response times for change requests measured in minutes
- Zero-downtime hardware maintenance without waiting for maintenance windows
- Unified server provisioning, monitoring and resource allocation across multiple generations of Windows, Linux and NetWare servers
- Guaranteed build consistency across systems
- Higher success rates for patch roll-outs
- Complete information for equipment counts, status and ownership

Getting Ready for Next-Generation Computing

For organizations that want to evolve their infrastructure toward next-generation computing, the first step is the implementation of a virtual infrastructure. For these organizations, VMware offers a comprehensive open Web services API for its implementation of virtual infrastructure that easily plugs into other vendor's automation and policy management frameworks. As enterprises select vendors for higher-level capabilities such as service level management or chargeback, VMware virtual infrastructure can be easily integrated.
4 VMware Virtual Infrastructure Products

ESX Server and VirtualCenter are part of a family of VMware virtual infrastructure products. The VMware platform includes:

- **VMware ACE** – An enterprise solution for IT desktop managers who want to provision and manage secure, standardized PC environments throughout the extended enterprise.

- **VMware Workstation** – Powerful desktop virtualization software for software developers/testers and IT professionals who want to streamline software development, testing and deployment in their enterprise. VMware Workstation allows users to run multiple x86-based operating systems, including Windows, Linux, and NetWare, and their applications simultaneously on a single PC in fully networked, portable virtual machines — no hard drive partitioning or rebooting required.

- **VMware GSX Server** - Enterprise-class virtual infrastructure software for x86-based servers that runs hosted on Windows and Linux x86 servers. GSX Server utilizes their native driver support to make VMware GSX Server the most flexible server virtualization product available.

- **VMware ESX Server** – Datacenter-class virtual infrastructure software that runs natively on the hardware to partition, consolidate and manage systems in mission-critical environments. ESX Server provides its own driver support and advanced resource management for the highest possible performance on certified hardware.
  - **VMware Virtual SMP** - An add-on module to VMware ESX Server that makes it possible for a single virtual machine to span multiple physical processors. VMware Virtual SMP allows a single guest operating system image to span multiple processors, making it ideal for scaling your virtual infrastructure to handle the most resource-intensive applications. Only VMware provides symmetric multiprocessing functionality for x86-based virtual machines.

- **VMware VirtualCenter** - Virtual infrastructure management software that provides a central and secure point of control for your GSX Server and ESX Server virtual computing resources. VirtualCenter creates a more responsive data center, which enables faster reconfiguration and reallocation of applications and services. It allows instant provisioning of servers. User-downtime is decreased. The data center becomes optimized.
  - **VMware VMotion** – An add-on module to VMware VirtualCenter that makes it possible to migrate a running ESX Server virtual machine to a different physical server connected to the same storage area network (SAN) without service interruption. VMotion enables continuous workload balancing and zero downtime maintenance.

- **VMware P2V Assistant** - An enterprise-class migration tool that transforms an image of an existing Windows physical system into a VMware virtual machine to enable fast and reliable physical to virtual machine migration.

- **VMTN Subscription** - VMware Technology Network (VMTN) Subscription is a service for developers and testers that provides a powerful suite of VMware products, support and upgrades as well as pre-built virtual machines for development and testing in a convenient, low-cost annual subscription.

> "Once we introduced VMware ESX Server, it caught on faster than I could have imagined. Even more amazing than the product’s efficiency was the way it reduced our costs. VMware probably saved us several hundred thousand dollars this year on hardware purchases alone. As QUALCOMM grows, we anticipate even greater savings."

-- Paul Poppleton, IT Manager, QUALCOMM
Virtual Infrastructure Nodes

The primary building blocks required to build a virtual infrastructure solution include one or more Virtual Infrastructure Nodes (VINs) and VMware VirtualCenter. Virtual Infrastructure Nodes bundle the most popular VMware platform components to simplify ordering and provide a discount over the individually priced components. The available VIN options include the GSX Server VIN (which includes VMware GSX Server and VirtualCenter Agent) and the ESX Server VIN (which includes ESX Server, VirtualCenter Agent, VMotion and Virtual SMP). IT managers can select either GSX Server or ESX Server VINs, or use a combination of both, based on their unique virtual infrastructure requirements.

5 VMware Virtual Infrastructure Business Solutions

<table>
<thead>
<tr>
<th>Business Use</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Implement Server Consolidation</strong></td>
<td>Reduced TCO across the computing infrastructure</td>
</tr>
<tr>
<td></td>
<td>Built-in headroom for expansion and scaling</td>
</tr>
<tr>
<td></td>
<td>Maximum hardware utilization</td>
</tr>
<tr>
<td></td>
<td>Simplified system management</td>
</tr>
<tr>
<td><strong>Lower IT Costs and Improve Flexibility and Responsiveness</strong></td>
<td>Improve utilization rates up to 60-80% for x86 servers</td>
</tr>
<tr>
<td>Use VirtualCenter to deploy and manage ESX Server Virtual Infrastructure Nodes and manage your hardware resources as a single pool of computer, storage and networking power.</td>
<td>Provisioning times for new applications measured in tens of seconds, not days</td>
</tr>
<tr>
<td></td>
<td>Response times for change requests measured in minutes</td>
</tr>
<tr>
<td></td>
<td>Zero-downtime hardware maintenance without waiting for maintenance windows</td>
</tr>
<tr>
<td><strong>Deliver High Availability and Guarantee Service Levels</strong></td>
<td>Protection against non-hardware errors and single point of failure for higher availability</td>
</tr>
<tr>
<td>Protect critical data in secure virtual machines and isolate multiple servers that run together at near-native performance levels on standard x86-based hardware.</td>
<td>Run resource-intensive SMP applications such as Oracle, SQL Server, Microsoft Exchange server, SAP, Siebel, Lotus Notes, BEA WebLogic and Apache</td>
</tr>
<tr>
<td></td>
<td>More control over IT performance metrics</td>
</tr>
<tr>
<td></td>
<td>Run IT as an enterprise service provider, delivering better service levels to customers</td>
</tr>
<tr>
<td><strong>Dramatically Improve and Lower the Cost of Disaster Recovery Capability</strong></td>
<td>Streamline Disaster Recovery management</td>
</tr>
<tr>
<td>Create a unified disaster recovery platform that increases availability, reduces recovery time and lowers hardware and operational costs.</td>
<td>Eliminate the need for costly 1-to-1 mapping of production and Disaster Recovery servers</td>
</tr>
<tr>
<td></td>
<td>Recover virtual machine images on any x86 hardware platform</td>
</tr>
</tbody>
</table>
6 ESX Server Overview

VMware ESX Server is virtual infrastructure software for partitioning, consolidating and managing systems as virtual machines in mission-critical environments. ESX Server Virtual Infrastructure Nodes transform physical systems into a pool of logical computing resources, where operating systems and applications are fully isolated within the multiple virtual machines that reside on physical servers. System resources are dynamically allocated to virtual machines based on need and service level guarantees, providing mainframe-class capacity utilization and control of server resources.

ESX Server runs directly on the system hardware to provide a secure, uniform platform for deploying, managing, and remotely controlling multiple virtual machines. ESX Server virtualization has three key abilities to enable a dynamic and flexible data center: Partitioning, Isolation and Encapsulation.

Partitioning

ESX Server uses a unique bare-metal (or hypervisor) architecture that inserts a small and highly robust virtualization layer between the x86 server hardware and the virtual machines. This approach gives ESX Server complete control over the server resources allocated to each virtual machine and it avoids the performance overhead, availability concerns and costs of server virtualization architectures built on a host operating system.

This virtualization layer performs all the necessary translations to mask the physical hardware resources from the guest OS. The guest OS sees a consistent set of virtual hardware, regardless of what type of physical hardware the server contains. This means, for example, that regardless of the specific network controller the physical server is using, the guest OS will see only the network controller defined by the standardized virtual hardware set in ESX Server.

Because applications interact only with the associated guest OS and not with the underlying virtual hardware, once OS compatibility with the virtual hardware is established, application compatibility is not an issue. This hardware independence enhances reliability due to the small number of device drivers required for the virtual hardware and, thus, for each virtual machine OS. Multiple operating systems can be run in virtual machines on one physical machine to fully utilize server resources, and they can all share any high availability features of the server.

Isolation

The virtualization layer also provides the ability to completely isolate one virtual machine from another at the hardware level. Each virtual machine includes a completely separate OS, registry, applications, and data files. Because each OS is isolated, one OS cannot communicate with or leak data to any other OS, other than through networking mechanisms similar to those used to connect separate physical machines. Errors or user actions that interfere with the operation of the OS and applications running in one virtual machine have no effect on the continuing operation of other virtual machines on the same server.

This isolation exists at the hardware layer as each virtual machine and the console are given time-slices of the processor and thus never concurrently share a kernel or any processes. In a real environment, what this means is that applications in one virtual machine can encounter viruses or blue screen their operating system, and there is no effect on any other virtual machine. Multiple off the shelf operating systems can be run side by side while still providing application owners with full protection from the stability and performance problems of other applications during server consolidation.
Encapsulation

VMware encapsulates the entire state of a virtual machine including the memory, disk images, and I/O device state into as few as two files. The two files include a short text file defining the configuration of the virtual machine and a virtual disk file that contains its data. Thus, the virtual machine can be copied, saved, and moved like a file.

You can move entire virtual machines among development, testing, and production environments simply by moving the virtual machine state file from one physical system to another. This allows you to deploy and redeploy virtual machines easily and flexibly even across servers that vary significantly in their hardware configuration.

Other notable features of ESX Server include:

Broad Server Support

ESX Server has been tested and fully supports most common x86 server and blade systems from the leading hardware vendors such as Dell, HP, IBM, Fujitsu Siemens, NEC, Sun, Bull, Unisys and Intel. ESX Server can support large host systems (up to 64GB of host memory, 256TB of storage, 16 host processors, and 80 powered-on virtual machines) for scalability, extensibility, and robustness. Additionally, ESX Server is qualified with systems management applications including HP InsightManager 7.2, Dell OpenManage 4.3 and IBM Director 4.21.

Virtual SMP

ESX Server supports Symmetric Multiprocessing (SMP) virtual machines, with single or dual virtual CPUs. VMware Virtual SMP is an add-on module included in the VIN bundle that makes it possible for a single virtual machine to span multiple physical processors. VMware Virtual SMP allows multiple processors to work in parallel while using only a single guest operating system image, making it suitable for even the most resource-intensive applications.

ESX Server Multiplies the Benefits of SANs & High Availability Hardware

By virtualizing access to hardware, ESX Server multiplies the benefits of using high availability hardware as all virtual machines can take advantage of high availability features:

- **CPU** - A 4-way server can host 20-30 virtual machines with any subset of them being able to dynamically scale up as needed within their allocations and use a larger share of the processing pool.

- **Memory** – Using memory over-commitment, a server with 6 GB of physical memory can act like a server with 12 GB of virtual memory. ESX Server will dynamically manage the memory and force virtual machines to page memory based on their own priorities once all the physical memory is in use. ESX Server also employs a feature called transparent page sharing to conserve memory by identifying memory pages that are identical across multiple VMs (such as multiple VMs with the same OS running) and storing them only once.

- **Storage** – Two paired Host Bus Adapters (HBAs) can support, for example, 32 virtual disks on a SAN in a fault tolerant manner. ESX Server maximizes storage area network (SAN) availability by providing multi-pathing or automatic path failover in case of HBA, switch, or storage controller failure. It increases scalability and eases management by allowing system administrators to direct traffic from specific HBAs to individual logical units (LUNs) and discover new LUNs and devices while virtual machines are running.

- **Network** – ESX Server supports NIC teaming to increase network reliability and performance while simplifying network topologies. NIC teaming enables administrators to group two through ten physical network interface controllers (NICs) into one single virtual network device that can appear as a dedicated virtual NIC to each of 32 separate virtual machines. By binding all these physical NICs together, customers can improve network availability by creating redundancy in the case of NIC failure and increase performance by dynamically load-balancing traffic between all available physical NICs. ESX Server also supports Virtual LAN tagging to enable the creation of multiple logical LANs within or across physical network segments.
VMFS File System

ESX Server includes a VMFS file system that provides optimized I/O performance for virtual disk files, high availability features and support for large storage configurations. With the VMFS file system, users can dynamically grow the size of a file system while ESX Server is running, access the same file system from multiple ESX Server hosts simultaneously, reconfigure storage without powering off machines, and support file sizes up to 64TB.

Fine Grained Resource Controls and Workload Management

ESX Server allows users to grant specific allocations for CPU, disk, memory, and network bandwidth for each virtual machine and dynamically change these resource allocations on the fly. For example, an administrator can create a virtual machine with a minimum CPU percentage of 30% and a maximum CPU percentage of 80%, and this virtual machine will always have at least 30%, and never more than 80%, of a physical CPU's resources.

Additional white papers and information on these ESX features and their usage are available on the VMware website at http://www.vmware.com/support/resources/esx_resources.html.
7 VirtualCenter Overview

Enterprises that deploy hundreds of virtual machines should take advantage of VirtualCenter, the secure and centralized management product that helps administrators manage ESX Server and GSX Server deployments. VirtualCenter is the centerpiece of the virtual infrastructure, enabling IT staff to easily manage workloads across multiple systems without requiring a major investment in additional resources or training. With VirtualCenter, an administrator can manage hundreds of Microsoft Windows NT®, Windows 2000, Windows Server 2003, Windows XP, Linux and NetWare servers from a single point of control, giving IT managers complete control over their large-scale virtual infrastructure. Servers can be instantly provisioned and quickly configured to support applications and services, so user-downtime is decreased. VirtualCenter uniquely leverages virtual computing, storage, and networking to improve enterprise resource management and reduce costs.

VirtualCenter provides:

Centralized Management

VirtualCenter provides a Windows-based management client that is designed to facilitate the management of thousands of virtual machines from a single location. The VirtualCenter management system includes all the features expected from a modern management environment: performance monitoring, alerts, remote access, task scheduling, reporting, and robust access control.

Monitoring

Administrators can monitor system availability and performance in real time: viewing host server and virtual machine power state, system status and current CPU, and memory utilization. VirtualCenter allows you to track performance utilization for host servers or break it down by individual virtual machine. Pre-configured graphs display the current: CPU usage, memory usage, disk I/O, and network I/O. Views of historical performance data can be customized by the administrator to quickly identify possible performance issues and identify the best hosts for new virtual machines.

Alert Notification

VirtualCenter includes an alert notification system that allows administrators to create custom alarms based on triggers that are relevant to their business and IT needs. Threshold and event alerts can be configured for a large number of events within the virtual infrastructure, including server failures and over- and under-utilization events. By default, VirtualCenter has predefined alarms for CPU usage, memory usage, and heartbeat of all host servers and virtual machines. Users can set specific thresholds to trigger alarms and inform VirtualCenter to take action. A triggered alarm can result in an alert notification sent to system administrators via email and/or pager or an action being performed such as running a script to shutdown, suspend, or migrate a virtual machine.

Remote Access

VirtualCenter includes a fully integrated Remote Console, providing keyboard video mouse (KVM) access to running systems. This feature allows administrators to access the desktop of their virtual machines and administer their applications remotely over a network. Without ever stepping foot into the data center, an administrator can manage an entire virtual infrastructure using the VirtualCenter client, deploying new systems and migrating running systems between physical servers.

Automation

Using the task scheduling mechanism of VirtualCenter, several administrative tasks, including the provisioning of new systems, can be fully automated. The wizard-based task scheduler allows you to schedule deployments of new virtual machines, change the power state of virtual machines, and schedule migration of virtual machines.
Administrators can use the task scheduler to power down a virtual machine or set of virtual machines to perform nightly or weekly backups. For example, an administrator creates a new task to suspend a particular virtual machine, on a weekly basis, in order to perform a full system backup. The administrator can then create another task to resume that virtual machine after the backup is complete. Automating these tasks allows the backup or copy of the virtual machine to run unattended.

Security
VirtualCenter incorporates a robust access control framework, so IT staff can be granted appropriate access rights to manage the infrastructure. This allows administrators to control which applications and data that users can access. VirtualCenter integrates with Windows Active Directory authentication enabling IT organizations to use existing logins and user groups with no need to create an additional authentication structure.

Software Developer’s Kit
The VMware Virtual Infrastructure SDK provides a rich Web services API integration capability enabling routine events to be automated or triggered by external systems. The VMware SDK enables integration with existing management and monitoring solutions. Several server and software vendors have already integrated their products with VMware virtual infrastructure using the VMware SDK.

VMotion Technology
VMotion technology lets you move live, running virtual machines from one host to another while maintaining continuous service availability. VMotion transfers the entire system and memory state of a running virtual machine from one ESX Server to another. VMotion allows fast reconfiguration and optimization of resources across the virtual infrastructure because you can make changes on the fly without impacting users. VMotion enables zero-downtime maintenance and continuous workload consolidation for ESX Server hosts.

Instant Provisioning of New Servers
Instant provisioning enables administrators to create and deploy a new server in minutes, complete with an operating system and applications. It’s different than most provisioning solutions because it’s much faster and takes advantage of the uniformity of virtual hardware. VirtualCenter can also help streamline server provisioning by maintaining a repository of hardware independent virtual machine templates and using a wizard-based system to deploy these as new servers. Virtual machine templates are a quick and consistent method for adding new applications to your virtual computing infrastructure.

Benefits of Instant Provisioning:
- Respond faster to changing business needs
- Reduce server-provisioning time from weeks to minutes, allowing administrators to respond immediately to requests for IT services
- Automate and standardize server deployments and provisioning for disaster recovery
- Use templates to ensure consistency with current build and security policies
- Rapidly deploy new servers to meet demand, quickly recover from a system crash or natural disaster
- Fully leverage SAN storage, move/copy systems between LUNs and/or storage servers
- Reduce operation costs associated with server provisioning

Additional white papers and information on these VirtualCenter features and their usage are available on the VMware website at [http://www.vmware.com/support/resources/vc_resources.html](http://www.vmware.com/support/resources/vc_resources.html).
## 8 Example Customer Implementations

### Production Server Consolidation

<table>
<thead>
<tr>
<th>Contains server sprawl by consolidating servers into virtual machines hosted on fewer but more powerful physical systems.</th>
<th>Summary</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AIG Technologies</strong>&lt;br&gt;ESX Server helps AIG Technologies achieve a 50% increase in server deployment speed and 20:1 reduction in the number of servers.</td>
<td><a href="http://www.vmware.com/customers/stories/aig.html">www.vmware.com/customers/stories/aig.html</a></td>
<td></td>
</tr>
<tr>
<td><strong>7-Eleven</strong>&lt;br&gt;7-Eleven’s CPU utilization averages 50-70% on its VMware servers, compared to 6-8% on most other servers.</td>
<td><a href="http://www.vmware.com/customers/stories/7-eleven.html">http://www.vmware.com/customers/stories/7-eleven.html</a></td>
<td></td>
</tr>
<tr>
<td><strong>Cellcom</strong>&lt;br&gt;Leading cellular company in Israel, Cellcom, embraces virtualization technology to meet goals for business growth and provide superior customer service.</td>
<td><a href="http://www.vmware.com/customers/stories/cellcom.html">http://www.vmware.com/customers/stories/cellcom.html</a></td>
<td></td>
</tr>
<tr>
<td><strong>QUALCOMM</strong>&lt;br&gt;By enabling a 30:1 reduction in the number of servers, VMware ESX Server helps QUALCOMM save six figures on hardware-while freeing data center space to support the company’s rapid expansion.</td>
<td><a href="http://www.vmware.com/customers/stories/qualcomm.html">www.vmware.com/customers/stories/qualcomm.html</a></td>
<td></td>
</tr>
</tbody>
</table>

### Software Development Optimization

<table>
<thead>
<tr>
<th>Virtualize complete test and development environments and save them as files.</th>
<th>Summary</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Abacus International</strong>&lt;br&gt;VMware ESX Server, GSX Server, VirtualCenter and WorkStation achieve a 19:1 server consolidation, accelerate legacy application migrations and enhance productivity with automated testing and development processes</td>
<td><a href="http://www.vmware.com/customers/stories/abacus.html">http://www.vmware.com/customers/stories/abacus.html</a></td>
<td></td>
</tr>
</tbody>
</table>
### Business Continuity

<table>
<thead>
<tr>
<th>Baptist Healthcare System</th>
<th>Improve business continuity by taking advantage of virtual infrastructure hardware independence and application portability</th>
<th>Baptist Healthcare System uses full line of VMware products for cost savings, ease of management and high performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subaru of Indiana Automotive</td>
<td>Subaru of Indiana Automotive cuts downtime 40% with VMware Virtual Infrastructure</td>
<td><a href="http://www.vmware.com/customers/stories/subaru.html">http://www.vmware.com/customers/stories/subaru.html</a></td>
</tr>
<tr>
<td>neverfail group</td>
<td>VMware ESX Server protects against vulnerabilities of physical servers while reducing costs and enhancing competitive advantage</td>
<td><a href="http://www.vmware.com/customers/stories/neverfail.html">http://www.vmware.com/customers/stories/neverfail.html</a></td>
</tr>
</tbody>
</table>

Summary

- BB&amp;K uses ESX Server to automate processes and simplify core business objectives.  
- Award-winning hospital uses VMware ESX Server to optimize computing for hospital staff so they can deliver the best healthcare and services.  
- Subaru of Indiana Automotive cuts downtime 40% with VMware Virtual Infrastructure  
- VMware ESX Server protects against vulnerabilities of physical servers while reducing costs and enhancing competitive advantage
9 Evaluation Planning & Environment Setup

9.1 Planning Worksheet

Technical Configuration Checklist

Below are tasks and reminders that should be completed before proceeding to install the software.

☐ Server system is supported by ESX Server? - See ESX Server System Compatibility Guide
☐ Server system contains VMware Hardware Compliant I/O Adapters? - See the I/O Adapter Compatibility Guide
☐ Server has at least two (preferably 3 for VMotion) LAN-connected approved NICs? - See the I/O Adapter Compatibility Guide
☐ Server has a supported SAN and HBA configuration if evaluating use with a SAN and VMotion? See the SAN Compatibility Guide
☐ Server system and I/O components are at latest BIOS / Firmware?
☐ Server has ample memory for testing requirements? - (2GB minimum, preferably 3GB+)
☐ Server contains ample local storage space for Service Console and recommended partitions? (9GB minimum, 36GB+ recommended)
☐ A LAN connected workstation / server for the VirtualCenter Management Server is available that can get to ESX Server subnet for configuration?
☐ User has ample fixed IP addresses for console, VMNIC(s), and guest VMs? (VMware does support DHCP, but static addresses are generally simpler to manage)
☐ User already has VMware install media? (Media Kit CD or download from evaluation site)
☐ User already has VMware license information? (Sent via email following evaluation request)
☐ User has all necessary operating system installation media, license keys and service packs to support operating system installations on virtual machines? (For example, Windows 2003 Server with Service Packs)

System Configuration Information

Please enter in the information for the ESX Server systems that will be used.

Manufacturer: Circle Dell, HP, IBM, Fujitsu Siemens, NEC, Sun, Bull, Unisys or Intel
Product ________________________ Model ________________________
Number of Processors _______ Speed ______ GHz
Dual Core and/or HT enabled? ________________
Amount of Memory _______ GB

Local Disk Storage

Disk Vendor ________________________
Make ________________________ Model ________________________
Local Storage _______ GB, RAID Type _______
SAN FC HBAs (if used)
QLogic Model ______________________________
Emulex Model ______________________________
Other HBA _________________________________

SAN Disk Storage (if used)
SAN Storage _______ GB, RAID Type _______
Anticipated VMFS LUN _____________________
SAN Switch Vendor ___________________________
Make ______________________ Model ____________________

Network Interfaces
VMware officially supports Intel and Broadcom network cards
NIC #1 – Vendor ____________ Model ___________ Speed _______________
NIC #2 – Vendor ____________ Model ___________ Speed _______________
NIC #3 – Vendor ____________ Model ___________ Speed _______________
ESX Server Hostname __________________ IP Address ___________________
VirtualCenter Server Hostname __________________ IP Address ___________________
Netmask ______________________
Gateway ______________________
DNS Server (Primary) __________________
DNS Server (Secondary) __________________

User Accounts
ESX Server User ID _root_________ Password ___________ Full Name _________________
ESX Server User ID _esxuser_______ Password ___________ Full Name _________________
VirtualCenter User ID _vcuser_______ Password ___________ Full Name _________________

VMware Evaluation Serial Numbers
ESX Server 1 Serial Number _______ _______ _______ _______
ESX Server 2 Serial Number _______ _______ _______ _______
Virtual SMP 1 Serial Number _______ _______ _______ _______
Virtual SMP 2 Serial Number _______ _______ _______ _______
VMotion 1 Serial Number _______ _______ _______ _______
VMotion 2 Serial Number _______ _______ _______ _______
VirtualCenter Agent 1 Serial Number _______ _______ _______ _______
VirtualCenter Agent 2 Serial Number _______ _______ _______ _______
VirtualCenter Mgmt Server Serial Number _______ _______ _______ _______
Operating Systems and Applications

Please mark all operating systems and service packs that will be tested:

Microsoft
___ Windows Server 2003 Enterprise Edition
___ Windows Server 2003 Standard Edition
___ Windows Server 2003 Web Edition
___ Windows XP Professional (Service Pack 1 or 2)
___ Windows 2000 Server (Service Pack 3 or 4)
___ Windows 2000 Advanced Server (Service Pack 3 or 4)
___ Windows NT 4.0 Server (Service Pack 6a)

Linux
___ Red Hat Linux 7.2, 7.3, 8.0 and 9.0
___ Red Hat Enterprise Linux (AS) 2.1 (Update 5)
___ Red Hat Enterprise Linux (AS) 3.0 (Update 3)
___ SuSE Linux 8.2, 9.0 and 9.1
___ SuSE Linux Enterprise Server (SLES) 8 and 9

Novell
___ Novell NetWare 6.5 (Service Pack 2)
___ Novell NetWare 6.0 (Support Pack 5)
___ Novell NetWare 5.1 (Support Pack 7)

FreeBSD
___ FreeBSD 4.9

Other _______________________________
Applications to be Tested

Below is a list of applications that VMware customers commonly deploy within virtual machines. Mark all applications and add any additional applications that your organization may consider evaluating for consolidation onto virtual infrastructure.

<table>
<thead>
<tr>
<th>Software Categories</th>
<th>Software Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Services</td>
<td>Microsoft IIS, Netscape, Apache, Allaire Coldfusion</td>
</tr>
<tr>
<td>Application Servers</td>
<td>BEA WebLogic, IBM WebSphere, ASP</td>
</tr>
<tr>
<td>Enterprise Messaging</td>
<td>Microsoft Exchange, Lotus Notes, Groupwise, Sendmail, Other POP &amp; IMAP services</td>
</tr>
<tr>
<td>Database</td>
<td>Oracle, Microsoft SQL Server, IBM DB2</td>
</tr>
<tr>
<td>File and Print Services</td>
<td>Microsoft, Novell, Samba/CIFS, NFS</td>
</tr>
<tr>
<td>Remote Session Access</td>
<td>Citrix MetaFrame, Windows Terminal Services</td>
</tr>
<tr>
<td>Enterprise Applications</td>
<td>SAP, Siebel, Peoplesoft, J.D. Edwards, Microsoft Great Plains, Oracle Applications</td>
</tr>
<tr>
<td>Business Integration</td>
<td>Microsoft BizTalk, IBM MQSeries</td>
</tr>
<tr>
<td>Helpdesk Applications</td>
<td>Remedy</td>
</tr>
<tr>
<td>System Management</td>
<td>HP Opneview, Tivoli, MS Systems Management Server, VMware VirtualCenter</td>
</tr>
<tr>
<td>Backup Services</td>
<td>Veritas BackupExec, Veritas NetBackup, Tivoli Storage Manager, CA ArcServe</td>
</tr>
<tr>
<td>Network Services</td>
<td>Windows NT / 2000 Domain Controllers, MS Active Directory, Sun One Directory Server, LDAP, WINS, DHCP, DNS</td>
</tr>
<tr>
<td>Firewall / Proxy Services</td>
<td>Squid, Netscape Proxy Server, Microsoft ISA</td>
</tr>
<tr>
<td>Custom Developed &amp; Legacy Applications</td>
<td>Custom NT and Linux applications</td>
</tr>
<tr>
<td>Development and Quality Assurance</td>
<td>Rational TestSuite, Microsoft Visual Studio, IBM VisualAge, Mercury Interactive WinRunner</td>
</tr>
</tbody>
</table>
9.2 Overview of the Evaluation Deployment

The diagram below shows an overview of a standard VirtualCenter infrastructure deployment with a VirtualCenter Server connecting to multiple VirtualCenter Clients and multiple Virtual Infrastructure Nodes (VINs). The VINs can use local SCSI storage for virtual machines or preferably a storage area network to be able to utilize VMotion technology and increase flexibility and business continuity.

The next diagram shows a simplified view of a virtual infrastructure deployment for this evaluation where the VirtualCenter Client and Management Server and Database are all installed on the same computer to minimize hardware requirements and the ESX Virtual Infrastructure Node (VIN) is using local SCSI storage for both the ESX Server installation and for virtual machine storage. Optional activities in chapters 15 and 16 of this evaluation guide include using a shared SAN to store virtual machines for multiple ESX Servers. This configuration enables VMotion migrations of running virtual machines across ESX Server hosts.

Note that it is possible if an extra system for VirtualCenter is not available to install the VirtualCenter Server into a virtual machine on one of the ESX Servers it will manage. In production deployments, VMware recommends that the VirtualCenter Management Server and database components be installed on multiple servers and/or in separate virtual machines.
9.3 Typical Evaluation Timeline

This section outlines a test plan for evaluating an ESX Server Virtual Infrastructure Node managed by VirtualCenter. This timeline highlights the common tasks when setting up an ESX Server and VirtualCenter, creating virtual machines and managing the ESX Server and the virtual machines from VirtualCenter. The evaluator may choose to modify this section where appropriate to fit within their environment. This list is to serve as a guideline only. The timeline associated with the checklist represents suggestions for a typical 30-day VMware evaluation period.

Evaluation Planning & Environment Setup
Timeline: Complete prior to software installation
- Verify that your hardware meets the requirements on the VMware compatibility lists
- Confirm that target ESX Server and VirtualCenter Server and client systems have network connectivity
- Confirm access to installation media, documentation, web support forums, etc

ESX Server & VirtualCenter Installation & Overview
Timeline: Week 1: Day 1
- Install ESX Server on the designated server
- Install Remote Console on management workstation
- Install VirtualCenter Management Server on the designated server using the default Access database
- Install VirtualCenter Management Client on the management workstation

Virtual Machine Functional Testing
Timeline: Week 1: Day 2-5
- Create a virtual machine
- Install the virtual machine operating system using local media or operating system ISO image
- Power on the virtual machine and install VMware Tools in the virtual machine
- Configure and test basic network connectivity of virtual machine
- Create a template from a virtual machine
- Deploy and customize the template as a new virtual machine
- Clone a virtual machine to create a new one
- Create a scheduled task
- Create an alert
- Optionally configure the ESX Server to store virtual machines on a SAN
- Optionally install a second ESX Server, configure and run VMotion Migration

Application Functional & Load Testing
Timeline: Week 1-4
- Install target test applications in virtual machine
- Configure application settings in virtual machine per your standard process
- Application functional test - Application starts without errors and functions as it does on a physical server
- Simulate actual ‘real world’ load on application in the virtual machine
- Monitor virtual machine performance with existing performance tools such as PerfMon
- Have end user test core functionality of applications in virtual machines
### 9.4 Hardware Requirements for ESX Server

Make sure the server you intend to install ESX Server on meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Minimum Server Requirements</th>
<th>VMware ESX Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processors</td>
<td>2-16 Processors</td>
</tr>
</tbody>
</table>
| CPU Speed                   | 1 GHz Pentium III Xeon or above  
|                             | 1 GHz AMD Opteron or above   |
| RAM                         | 512MB minimum; 2+GB recommended (sufficient RAM for each virtual machine and the service console) |
| Ethernet Controllers        | 1-3 Ethernet Adapters  
|                             | ▪ 1 Ethernet Adapter is required for the Service Console (this adapter can be shared with virtual machines but this is not recommended for performance and security reasons),  
|                             | ▪ 1 or more Ethernet Adapters are required for Virtual Machines to access the network through virtual switches, and  
|                             | ▪ 1 additional dedicated Ethernet Adapter is required to support VMotion Migrations. VMware recommends using a dedicated Gigabit connection for VMotion migrations for high performance.  
|                             | Supported controllers include:  
|                             | ▪ Broadcom® NetXtreme 570x Gigabit controllers  
|                             | ▪ Intel PRO/100 adapters  
|                             | ▪ Intel PRO/1000 adapters  
| Disk Controllers            | 1 Internal SCSI controller with locally attached SCSI Hard Drive  
|                             | 1 Host Bus Adapter connected to a SAN (Optional)  
|                             | The supported SCSI controllers are Adaptec® Ultra-160 and Ultra-320, LSI Logic Fusion-MPT and most NCR/Symbios™ SCSI controllers. The supported RAID controllers are HP® Smart Array, Dell® PercRAID (Adaptec RAID and LSI MegaRAID), IBM® (Adaptec) ServeRAID, Intel RAID and Mylex RAID controllers. The supported Fibre Channel adapters are Emulex™ and QLogic™ host-bus adapters (HBAs).  
|                             | A SCSI disk, Fibre Channel LUN or RAID LUN with unpartitioned space. In a minimum configuration, this disk or RAID is shared between the service console and the virtual machines.  
| Disk Space                  | Sufficient disk space on local SCSI disks or on the SAN for the virtual machines to be deployed on VMFS formatted partitions.  
|                             | 9GB internal minimum; 36GB+ recommended (4GB is required for ESX Server and service console installation. The additional space can be used for virtual machines and to store guest operating system ISO images. Virtual machines running Windows 2003 Server typically need 4GB of space for the operating system and applications.) Note that while a local SCSI disk or a SAN is required for VMFS, additional non-VMFS partitions and even the main ESX Server installation are supported on IDE disks. |
9.5 **Hardware Requirements for VirtualCenter Management Server**

Make sure the server, workstation or laptop you intend to install VirtualCenter Management Server on meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Minimum Server Requirements</th>
<th>VMware VirtualCenter Management Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processors</td>
<td>1 Processor</td>
</tr>
<tr>
<td>CPU Speed</td>
<td>1 GHz or faster x86 Processor</td>
</tr>
<tr>
<td>RAM</td>
<td>512MB, 2GB preferred</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows XP Professional</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Server or Advanced Server</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Enterprise, Standard, Web Editions</td>
</tr>
<tr>
<td>Ethernet Controllers</td>
<td>1 10/100 Mbps NIC</td>
</tr>
<tr>
<td>Disk Space</td>
<td>30MB VirtualCenter installation</td>
</tr>
<tr>
<td></td>
<td>10MB VirtualCenter database</td>
</tr>
</tbody>
</table>

Note that if a system isn’t available to host the VirtualCenter Server and Database, they can be installed and hosted within a virtual machine on the ESX Server.

**Requirements for Optional VMotion Evaluation**

Further detail on VMotion Requirements is available in section 16.2 of this document, but you will essentially need the following hardware to evaluate the VMotion migration of running virtual machines between ESX Servers:

- 2 or more ESX Servers with compatible processors to support virtual machine transfer from one to another
- Shared SAN for virtual machine storage so that virtual machine files do not have to be moved
- Dedicated Gigabit Ethernet Network between the ESX Servers to support the rapid transfer of data
9.6 Hardware Requirements for Remote Management Workstation

Make sure the workstation or laptop you intend to install VirtualCenter Management Client and the Remote Console on meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Minimum Server Requirements</th>
<th>VMware VirtualCenter Management Client &amp; Remote Console Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Speed</td>
<td>Standard x86-based computer</td>
</tr>
<tr>
<td></td>
<td>266 MHz or faster processor</td>
</tr>
<tr>
<td>RAM</td>
<td>64MB RAM minimum</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows XP or XP Professional</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Professional, Server or Advanced Server</td>
</tr>
<tr>
<td></td>
<td>Windows NT 4.0 Workstation or Server, Service Pack 6a</td>
</tr>
<tr>
<td></td>
<td>Linux (Remote Console Client only)</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Internet Explorer 6.0 or higher</td>
</tr>
<tr>
<td></td>
<td>Netscape Navigator® 7.0</td>
</tr>
<tr>
<td></td>
<td>Mozilla 1.x</td>
</tr>
<tr>
<td>Ethernet Controllers</td>
<td>10/100 Mbps NIC</td>
</tr>
<tr>
<td>Disk Space</td>
<td>10MB free disk space required for basic installation</td>
</tr>
</tbody>
</table>
9.7 Guest Operating Systems Supported

The following table lists the supported guest operating systems in ESX Server 2.5. VMware Virtual SMP can be used to configure guest operating systems marked as SMP-Capable for dual virtual CPU configurations.

<table>
<thead>
<tr>
<th>Guest Operating System</th>
<th>SMP Capable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional (Service Pack 1 or 2)</td>
<td>No</td>
</tr>
<tr>
<td>Windows 2000 Server &amp; Advanced Server (Service Pack 3 or 4)</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows NT 4.0 Server (Service Pack 6a)</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Linux 7.3 and 8.0</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Linux 7.2 and 9.0</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux (AS) 2.1 (Update 5) and 3.0 (Update 3)</td>
<td>Yes</td>
</tr>
<tr>
<td>SUSE Linux 8.2</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux 9.0 and 9.1</td>
<td>Yes</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server (SLES) 8 and 9.0</td>
<td>Yes</td>
</tr>
<tr>
<td>Novell NetWare 6.5 (Support Pack 2) 5, 6.0 (Support Pack 5) and 5.1 (Support Pack 7)</td>
<td>No</td>
</tr>
<tr>
<td>FreeBSD 4.9</td>
<td>No</td>
</tr>
</tbody>
</table>

9.8 Download Product Binaries and Burn to CD-ROM

After you successfully sign up for the VIN evaluation, you will receive an email containing your evaluation license keys and instructions for downloading ESX Server and VirtualCenter. Once you have accessed and downloaded the software, burn the ISO image files to an ESX Server CD-ROM and a VirtualCenter CD-ROM to support the installation.
9.9 Helpful Technical Tips

**How to Access the ESX Server Service Console Remotely**

You can use a free SSH client to access the service console remotely. Putty is available for download at [http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html](http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html). No installation is required. Simply run the client, select the SSH radio button (rather than the default telnet), enter the IP address of your ESX Server and click the Open button to connect. You can save this profile for future access.

**How to Transfer Files to the ESX Server using FTP Utilities**

Once you have enabled FTP Access on the ESX Server (see step 36 on page 37), you can use a free FTP Client such as WinSCP ([http://winscp.net/eng/download.php](http://winscp.net/eng/download.php)) to access the directory structure on the ESX Server and copy over files as needed. A common example would be to place ISO images of operating system installation disks in the `/vmimages` partition.

**How to Transfer Files to the ESX Server using a Mounted SMB Share**

The `smbmount` command can be used mount a remote SMB share from the ESX Server Service Console. First login to the Service Console as `root` either directly from the server or remotely. Run `smbmount` using the following syntax:

```
smbmount //<Target_server_name>/<share_name> /<mount_path> -o
    ip=<$Target_server_ip$>,username=<$username$>,password=<$password$>
```

You can run `smbclient -L <IP_address>` to identify the server and share names available on a target server.

**Shutdown the ESX Server Cleanly**

To shut ESX Server from the Service Console command line, use the following command:

```
Shutdown -h now
```

**Additional Troubleshooting & Performance Tuning Tools**

Both the ESX Server Management User Interface (MUI) and VirtualCenter provide significant detail on server activity and resource utilization, but several more granular tools are also available to support troubleshooting and performance tuning.

- **esxtop** - `esxtop` is a powerful tool that lists CPU utilization for each physical processor, memory utilization, and disk and network bandwidth for each for each device available to the ESX Server. Documentation on `esxtop` is available in a VMware document “Using esxtop to Troubleshoot Performance Problems” available at [http://www.vmware.com/pdf/esx2_using_esxtop.pdf](http://www.vmware.com/pdf/esx2_using_esxtop.pdf).

- **vmkusage** - The web-based vmkusage utility displays historical graphs that show physical server, ESX Server system and virtual machine statistics. By default, these graphs show the most recent, daily and weekly data. The vmkusage utility gathers the statistics it uses to generated the graphs from the ESX Server machine’s `/proc` nodes. Documentation on the vmkusage utility is available in a VMware document “Using vmkusage to Isolate Performance Problems” available at [http://www.vmware.com/pdf/esx2_using_vmkusage.pdf](http://www.vmware.com/pdf/esx2_using_vmkusage.pdf).
10 Installing ESX Server

This section describes how to install ESX Server on your server:

1. Ensure the server meets the minimum hardware requirements and is compatible with ESX Server.

2. Verify that a network cable is plugged into the Ethernet adapter that you are using for the service console and any Ethernet adapters that you will be using for virtual machines. The ESX Server installer needs this to properly detect that the machine has a network card. Also verify that the server is configured in the BIOS to boot from the CD-ROM.

3. If you are going to be evaluating ESX Server with the use of a SAN, remove any HBA fiber cables during the ESX install and plug them back in once ESX has been installed. This will ensure you don’t accidentally install the ESX Server Service Console on the SAN.

4. Power on the machine with the VMware ESX Server CD in the CD-ROM drive. The ESX Server begins its boot process. The Installation Boot Screen Options window will appear and offer alternatives to the standard graphical installation. You can use these options in the future to support more advanced installations such as installing ESX Server on an IBM Blade configuration or to boot from a SAN. Note that you also may need to use the Text-mode installer if your system uses a graphics chip not supported by ESX Server, or if your keyboard and mouse do not function properly using the graphical installer.

5. Press Enter to begin a standard ESX Server installation or let the timer automatically count down to begin the standard installation.

6. Press enter. The Welcome screen appears. Select Next to begin the installation.

7. The Installation Type screen appears. Select Install Default to install ESX Server on a new system. Note that this option performs a full installation and destroys any previously saved information on the selected partitions. Select Next to continue. A Custom install allows you to select additional configuration options for your keyboard and mouse.
8. The End User License Agreement screen appears. Read through the end user license agreement and check ![accept the terms in the license agreement](image). Select Next to continue.

9. The VMware ESX Server Serial Numbers screen appears. Enter the ESX Server serial number sent to you by email in the **VMware ESX Server** field. Note that entering the serial number is not a required step for completing the installation. You may enter it at a later time. If you skip this step, however, you will not be able to start virtual machines in your ESX Server. If you have a license for VMware Virtual SMP for ESX Server, enter that serial number in the **VMware Virtual SMP for ESX Server** field to configure your virtual machines with more than one virtual processor. Entering the serial number installs VMware Virtual SMP for ESX Server. Select Next to continue.

10. The Device Allocation screen appears to define how to set up your system devices. Configure the service console including reserved memory, SCSI storage controller, Ethernet controllers, and fibre channel devices.
11. Select Reserved Memory — The default amount of memory reserved for the service console, 192MB, is sufficient for managing up to eight virtual machines concurrently. Change this to 272MB for up to 16 virtual machines, 384MB for up to 32 virtual machines or 512MB for more than 32 virtual machines. Choose 800MB for the maximum number of virtual machines.

12. Configure SCSI Storage Controllers — Allocate storage adapters to be used by the service console and virtual machines on the server. Ensure that both the service console and the virtual machines have access to at least one storage device. A SCSI or RAID adapter should be shared if you want to use that adapter or array for both the service console and to host virtual machines. When you are allocating SCSI or RAID devices, the unit of device allocation is a PCI card device. You may connect multiple SCSI or RAID disks, CD-ROM drives, tape drives and other devices to the SCSI or RAID adapter. You should give as many SCSI or RAID devices to the virtual machines as possible to ensure that the majority of your mass storage resources are used by your virtual machines. Before continuing, ensure that a local SCSI disk is allocated to virtual machines and shared with the service console. This should be the default setting and not require any changes.

13. Configure Ethernet Controllers — Allocate network adapters to be used by the service console and virtual machines on the server. Note that the first network adapter discovered will automatically be allocated to the service console (this allocation can later be changed in the VMware Management Interface) and is required in order to manage the ESX Server remotely. All other network adapters should be allocated to virtual machines.

14. The Disk Partitioning Setup screen appears and lists two choices for the type of disk partition:
   a. Manual Partitioning — you manually create each partition. Be sure to delete any existing partitions. This is the recommended option for this evaluation installation.
   b. Automatic Partitioning — the installer estimates and creates default partitions on your disk. You can edit these automatic selections after they are suggested and before they are created. Automatic partitioning allows you to have some control concerning what data (if any) is removed from your system.

When using Automatic Partitioning, you can select to either remove all partitions or preserve an existing VMFS partition:
   a. Remove all partitions — removes all partitions on the system. This is the recommended option for new installations. Note that you will later see a warning screen confirming that you want to remove all partitions.
   b. Remove all partitions except VMFS — removes all partitions on the system but keeps the VMFS partition where your virtual machines are stored. This is the recommended option if you are re-installing and want to preserve your existing virtual machines on the VMFS partition.
   c. Installation Drives — lists the hard drive selections available. These are based on the hard drives detected by the ESX Server installer. The service console is installed on the hard drive selected.

In the Installation Drives dialog, ensure the correct SCSI disk is selected for the successful installation of the Service Console. The SCSI disk will likely be identified with a device name of sda or cciss rather than an IDE hard drive name of hda. Select Next to continue.
15. The Partitioning screen displays the partitions that ESX Server will create on the available disks. ESX Server requires a minimum of three primary partitions (/boot, / and swap), and the remaining recommended partitions are configured as logical partitions on the fourth extended partition.

16. Select New to create partitions described below. There is also a summary view of recommended partitions on the next page. For each new partition, be certain that the correct target drive is selected.

   a. Click New to create a boot primary partition on the installation disk. Set the mount point to /boot and the size to 50 MB. Check the box to Force to be primary partition. Click OK to close and save the changes.

   b. Click New to create a swap primary partition on the installation disk. Set the file system type to swap and the size to twice the amount of memory you reserved for the Service Console in the device allocation configuration. If you accepted the default of 192 MB of Service Console memory (suitable to support 8 VMs), then you would enter 384 MB here. Check the box to Force to be primary partition. Click OK to close and save the changes.

   c. Click New to create a root primary partition on the installation disk. Set the mount point to / and the size to 1800 MB. Check the box to Force to be primary partition. Click OK to close and save the changes.

   d. Click New to create a vmkcore logical partition on the installation disk. Set the file system type to vmkcore and the size to 100 MB. Click OK to close and save the changes. The core dump partition stores information generated if the VMkernel crashes. The core dump information is important in debugging any problems with the VMkernel.

   e. Optionally, click New to create a vmimages logical partition on the installation disk. Set the mount point to vmimages and the size to 10000 MB. Click OK to close and save the changes. This partition can hold templates and ISO images to support rapid provisioning so size it according to the quantity of files that might be stored there versus disk space available. This data partition can also be placed on another SCSI drive or an IDE drive on the ESX Server if desired. The alternative to creating a vmimages partition is to create a larger home directory and store images there.

   f. Click New to create a home logical partition on the installation disk. Set the mount point to /home and the size to 1800 MB. Click OK to close and save the changes. This partition will contain home directories for users of the Service Console. Separating home directories from the root file system by placing them in their own partition protects the root file system from filling. Note that this partition should be larger if you will be storing images here.

   g. Click New to create a var logical partition on the installation disk. Set the mount point to /var and the size to 2000 MB or as desired. This data volume can be placed on another SCSI or an IDE drive on the server if desired. Click OK to close and save the changes.

   h. Click New to create a temp logical partition on the installation disk. Set the mount point to /tmp and the size to 2000 MB or as desired. This data volume can be placed on another SCSI or an IDE drive on the server if desired. Click OK to close and save the changes.

   i. Click New to create the VMFS (Virtual Machine File System) logical partition on the installation disk. Set the file system type to vmfs2 and check the box to Fill to maximum allowable size. Click OK to close and save the changes.

   j. When finished creating partitions, the partition definition should be similar to this screenshot below. Select Next on the partitioning screen to continue.
Below is a summary of the recommended partitions:

<table>
<thead>
<tr>
<th>Mount Point</th>
<th>File System Type</th>
<th>Size (MB)</th>
<th>Additional Size Options</th>
<th>Force to be a Primary Partition</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>/boot</td>
<td>ext3</td>
<td>50 MB</td>
<td>Fixed Size</td>
<td>Select</td>
<td>Service Console</td>
</tr>
<tr>
<td>Not Applicable</td>
<td>swap</td>
<td>2x Service Console Memory (e.g. 384 MB)</td>
<td>Fixed Size</td>
<td>Select</td>
<td>Service Console</td>
</tr>
<tr>
<td>/ (root)</td>
<td>ext3</td>
<td>1,800 MB</td>
<td>Fixed Size</td>
<td>Select</td>
<td>Service Console</td>
</tr>
<tr>
<td>Not Applicable</td>
<td>vmkcore</td>
<td>100 MB</td>
<td>Fixed Size</td>
<td>Do not Select*</td>
<td>VMkernel</td>
</tr>
<tr>
<td>/vmimages**</td>
<td>ext3</td>
<td>10,000 MB or as desired</td>
<td>Fixed Size</td>
<td>Do not Select</td>
<td>Exported virtual disks, virtual machine templates, ISO images and other large files</td>
</tr>
<tr>
<td>/home</td>
<td>ext3</td>
<td>1,800 MB or as desired</td>
<td>Fixed Size</td>
<td>Do not Select</td>
<td>Personal files for service console users; VM config files and logs</td>
</tr>
<tr>
<td>/var</td>
<td>ext3</td>
<td>2,000 MB or as desired</td>
<td>Fixed Size</td>
<td>Do not Select</td>
<td>Used for files which can vary in size such as log files</td>
</tr>
<tr>
<td>/tmp</td>
<td>ext3</td>
<td>2,000 MB or as desired</td>
<td>Fixed Size</td>
<td>Do not Select</td>
<td>Used for temporary files</td>
</tr>
<tr>
<td>Not Applicable (automatically created as /vmfs/&lt;volume_name&gt;)</td>
<td>vmfs2</td>
<td>Rest of disk</td>
<td>Fill to maximum allowable size (or fixed size if not using rest of disk)</td>
<td>Do not Select</td>
<td>VMware File System (VMFS) – This is the location for local disk virtual machines not stored on a LUN</td>
</tr>
</tbody>
</table>

* By not forcing the fourth partition (/home in the above table) to be primary, an extended partition occupying the remainder of the disk will be created, and /home, and any subsequent partitions, will be created as logical partitions within the extended partition.

** The /vmimages partition is optional and sized at 10,000 MB (10 GB) as an example. Images and other working files can alternately be stored in a larger /home partition. In practice, these partitions should be sized according to the specific needs of your environment.
17. The Network Configuration screen appears. Enter the network parameters. Using a static IP address is highly recommended for the evaluation. The options are:
   a. **DHCP** — allows this process to determine network settings each time the ESX Server system boots. **Caution:** Selecting this option requires that your DNS server is capable of mapping the service console’s host name to the dynamically generated IP address. See the VMware ESX Server Administration Guide for instructions and cautions on setting up a DHCP-based service console.
   b. **Static IP** — enter the host name in the Hostname field, IP address in the IP Address field, the netmask in the Netmask field, the network gateway in the Gateway field and the primary and secondary name servers in the Primary DNS and Secondary DNS fields.

   **Note:** Be sure to include the full domain name if you are running with domains. **Note:** Setup does not ask for network parameters if you do not have a network card. Initially, only the first Ethernet card is enabled. All other network adapters are disabled. **Note:** If you need to later change the hostname of the ESX Server, refer to Knowledge Base article #861 on the VMware website for instructions.

18. Select **Next** to continue. The Time Zone Selection screen appears. Select your time zone.

19. Select **Next** to continue. The Account Configuration screen appears. Specify your desired root password. Root is the user name for the administrator on the ESX Server. Users with administrator privileges log in with this name when using the VMware Management Interface or the service console.
20. To add a user account, select Add. The Add User screen appears. Add at least one user such as esxuser. You need accounts for all users who need to log in to the VMware Management interface to create or manage virtual machines. If you wish, you may add those users at this time. Select OK to continue adding users as desired. Select Next to continue.

21. The About to Install screen appears and displays the location of the installation log file. Select Next to continue. The installer formats the disk and starts installing the packages.

22. Once the packages are installed, the Congratulations, ESX Server Installation is Complete screen appears. Reboot the system by clicking Next. Remove the CD-ROM from the drive when it is ejected during the reboot process.

23. After the full reboot, check the Service Console monitor. You should see a screen advising you to use a web browser to continue the setup process using the URL for the ESX Server Management User Interface (MUI). The URL will be the host name or IP address of the ESX Server.

24. From your desktop system, open a web browser to the IP address of your ESX Server to access the MUI. The first time you use a Web browser to make a secure connection to an ESX Server, a dialog box asks whether you want to accept the security certificate presented by the server. Accepting the certificate allows you to access the server through the VMware Management Interface. When you connect to the management interface with an Internet Explorer browser, a Security Alert dialog box appears. To see details of and optionally install the certificate, click View Certificate. Accept the certificate and proceed to continue.
25. Login to the VMware Management User Interface as user root. Note that if the local DNS server did not know the IP address of the ESX Server or the hostname you assigned to your ESX Server, you can put an entry in the hosts file of your desktop system.

26. This is the native Management User Interface (MUI) used for accessing individual ESX Servers independently of the VirtualCenter Management Client. We are using it here to perform some initial configurations and to provide a brief introduction to the MUI, but the rest of this evaluation will demonstrate managing ESX Servers from within VirtualCenter.

Note the warning about the non-existence of swap space and virtual Ethernet switches. These warnings will disappear once you complete the remaining configuration steps.

27. Click the Options tab to reach the Options page of the MUI to provide a volume label for your local VMFS. Note that if you are not logged in as root then the Options tab will not be available.
28. On the Options tab, click on Storage Management to access a summary of all the storage devices that are available to your ESX Server.

29. Find the VMFS you created and click the Edit link next to it to change the volume label to a name that reflects its purpose or location such as LocalVMFS. You should leave the other settings at their default values. Close these windows to return to the Options tab.

30. From the Status Monitor page of the MUI, click the Reconfigure link next to the warning about swap space to create a VMkernel swap file. This will take you to the Options tab where you will see that there are no swap files configured or active. Click the Create link to configure a swap file.
31. At the swap configuration screen, click OK to accept the defaults and create a VMkernel swap file. Make sure the swap file is always placed on local VMFS-2 storage and not on external storage. Click OK to continue.

32. The swap configuration page now shows your newly defined swap space, and shows that it will be activated at each reboot, but it is not currently active. Click Activate to begin using the new swap without needing to reboot. You are returned to the Status Monitor page.

33. Next follow the Reconfigure link next to the warning about virtual Ethernet switches to create the switches to be used by your virtual machines. You will now see a page describing virtual switches, port groups and their connections. Click the Create link at the bottom of the page to begin creating your switches.

34. Create two or three virtual switches changing the label from the default Network0 to a more descriptive label.
   a. Create a virtual switch with network label Internal0 with no bound network adapter
   b. Create a virtual switch with network label External0 with an outbound adapter
   c. If you are evaluating VMotion, create a third virtual switch VMotion for the dedicated VMotion network path.
35. Note that you will return here later to create additional switches based on the networking needs of future virtual machines. Review your virtual switches to ensure that each outbound adapter is bound to its own virtual switch, and that there is at least one internal virtual switch that is not bound to any physical NIC. The resulting configuration will show the two or three basic virtual switches. Close this window to return to the Status Monitor. Notice that both warnings are now cleared.

36. On the Options tab, click on Security Settings tab. Security is set to High by default for all ESX Server installations, disabling unnecessary server access protocols and encrypting all communication. If you need to access or transfer files to or from the ESX Server, you will need to selectively reduce the default High Security Settings to Medium, Low or a Custom level to enable services such as FTP, Telnet, SSH secure remote logins and NFS file sharing. Click OK to continue.

37. This completes the ESX Server configuration using the MUI client. You might spend a few minutes browsing the user interface to familiarize yourself with the options available.

For example, notice that there is a Manage Files link in the upper right corner of the MUI that lets you browse the files on the ESX Server. You can also elect to download and install the VMware Remote Console for Windows or Linux from the bottom of the Status Monitor window. This is a standalone version of the console browser available in the VirtualCenter client that allows you to view and manage virtual machines with keyboard and mouse input.

Close the window to logout when finished.
11 Installing VirtualCenter Server & Management Client

The following steps should be a straightforward installation of the VirtualCenter software into a Windows environment. A single installer package contains the VirtualCenter client, VirtualCenter server, and the VMware SDK Web service. You can install the VirtualCenter client and VirtualCenter server components separately or on the same Windows system. You can also repeat this installation to install just the VirtualCenter client on other computers for ease of access during the evaluation.

Note that if a system isn’t available to host the VirtualCenter Server and Database, these components can be installed and hosted within a virtual machine on the ESX Server. Refer to Chapter 2, “Creating and Configuring Virtual Machines”, in the ESX Server 2 Administration Guide for instructions on creating a virtual machine using the ESX Server Management User Interface. You can then install the VirtualCenter Server onto a virtual machine running on the ESX Server.

VirtualCenter supports three types of database formats:
- Microsoft Access (default)
- Microsoft SQL Server 2000, Microsoft SQL Server 7
- Oracle 8i, 9i, 10g

This evaluation will use the default Microsoft Access database for demonstration and trial purposes. Using the Microsoft Access database for production environments is not recommended for performance reasons.

Installing the VirtualCenter Server and Client

This section describes how to install VirtualCenter on your system when there is no other VirtualCenter installation present. To install the VirtualCenter client and server on your system:

1. Either load the installation disk image created earlier or download the VirtualCenter installer file from the VMware secure website to a local drive.

2. Run the installer. Double-click the VMware installation icon or select Start > Run and enter the location of the installer in the Run window. The VirtualCenter installer prepares to install the components. If you do not have Microsoft .NET Framework version 1.1 on your machine, a prompt appears to ask if you wish to install it. If you click Yes, then the installer automatically installs this package. If you have installed an older version, then the installer automatically upgrades your version to version 1.1.

3. Verify you are installing the VirtualCenter product. Click Next.

4. Accept the VMware license terms. Click the Accept button, then click Next.

5. Enter your customer information User Name and Organization name. Then click Next to continue the installation.
6. Select to perform a Custom setup to install both the Server and Client and click Next.

7. Select to install both the Client and the Server components. Click the down arrow next to the appropriate component and select from the drop-down menu to complete the Custom Setup screen. Click Next to continue with the installation.

8. Click the Use Access Database button and click Next to have the installer create the necessary Access database.
9. On the next VirtualCenter Web Service configuration window, enter a **user name** and **password** of a user in the administrators group on the local machine to enable Web Services access to the VirtualCenter Management Server.

10. Verify that you are ready to proceed with installation. Click **Install** to continue the installation.

11. Progress messages appear while the installation proceeds. The VirtualCenter installer, as specified, installs the VirtualCenter server, starts the VirtualCenter database, performs a default Access database setup of the open database connectivity (ODBC), registers and activates the VirtualCenter server, and installs the VirtualCenter client.

12. Click **Finish** to close the installation wizard. The selected VirtualCenter components are installed on your Windows computer.

**Note:** The VirtualCenter server must be able to send data to every VirtualCenter managed host and receive data from each VirtualCenter client. To enable any migration or provisioning activities between VirtualCenter managed hosts, the source and target hosts must be able to receive data from each other. During normal operations, VirtualCenter is listening for data from its managed hosts and clients on designated ports. Additionally, VirtualCenter assumes that its managed hosts are listening for data from VirtualCenter on designated ports. If there is a firewall between any of these elements, a hole must be created to allow data transfer to these designated ports. Refer to the VirtualCenter Users Guide for instructions if you need to connect your VirtualCenter server to clients and hosts through a firewall.

Also, an optional step to that can be employed to improve the performance of the Microsoft Access database:

1. Open the Windows ODBC Data Source Administrator. Select **Settings > Control Panel > Administrative Tools > Data Sources (ODBC)**.
2. Select the **System DSN** tab.
3. Select **ODBC Microsoft Access Setup**. Click **Options**.
4. Increase the buffer size and click **OK**. The default value is **2048**. Change it to **8192**.

Restart the VirtualCenter server, if it is running.
Starting the VirtualCenter Client and Logging On

When VirtualCenter is installed, all users in the Administrators group are assigned VirtualCenter Administrator privileges by default for the VirtualCenter environment. Permissions for all other VirtualCenter users need to be explicitly set by a VirtualCenter Administrator. VirtualCenter supports user groups for managing access rights. Users may belong to one or more groups to allow aggregate security assignments. Users assume the roles assigned to any group of which they are members.

To start a VirtualCenter client session:

1. Log on to your Windows system. The first time you start the VirtualCenter client, log on as an administrator of the local system. By default, administrators are allowed to log on to VirtualCenter. Administrators here are defined to be either:
   - Members of the local Administrators group if the VirtualCenter server is not a domain controller. Log on as either \(<\text{local host name}>\backslash\text{<user>}\) or \(<\text{user}>\), where \(<\text{user}>\) is a member of the local Administrators group.
   - Members of the domain Administrators group if the VirtualCenter server is a domain controller. Log on as \(<\text{domain}>\backslash\text{<user>}\), where \(<\text{domain}>\) is the domain name for which the managed host is a controller and \(<\text{user}>\) is a member of that domain's Domain Administrators group. This practice is not recommended.

2. Launch the VirtualCenter client. Double-click a shortcut or select the application through Start > Programs > VMware > VMware VirtualCenter.

3. When you start the VirtualCenter client, log on to the VirtualCenter server. Enter or select the VirtualCenter server name, your user name and your password for that VirtualCenter server. Click Log In to continue. The default localhost location is the local Windows server or machine where you started the VirtualCenter client. Using localhost in the Log In screen, the VirtualCenter client assumes the VirtualCenter server is located on the same host as the VirtualCenter client. Alternatively, click the Server list arrow and select from the list of available VirtualCenter servers or type the name of the VirtualCenter server on your network. An IP address or a name is acceptable. If you created the example vcuser as the VirtualCenter user for this server, you will need to create a user account with a password on the Windows system where VirtualCenter is running to be able to login.

4. Create a license file by placing all your VirtualCenter licenses you received via email into a plain text file. This license file should include the licenses for VirtualCenter Management Server, VirtualCenter Agent and VMotion. Ensure that the license key string starts in column 1 of the license text file. That is flush left. Do not have any leading spaces at the beginning of the license file. In addition, be sure to keep the integrity of the licenses you are given; that is, keep the hyphenation format as it is provided. For example, xxxxxxx-xxxxxxx-xxxxxxx-xxxxx.

5. If your VirtualCenter server does not have its licenses installed yet, the licensing screen appears. To make licenses available to the VirtualCenter server:
   a. Click the Add Licenses button and select the license file created in the previous step.
   b. Click Open and you will see the licenses added to the list.
   c. Click Done on the Licensing screen. You are now ready to add hosts.
6. Next, in the inventory pane of the VirtualCenter manager, select the **Server Farms** node and select the **File > New Farm** menu to create a new Farm. Name it something descriptive like **Evaluation Farm**. You can optionally select to create a second server farm called **Production Farm**.

7. Now select the **Evaluation Farm** you just created and select **File > New > Host** from the menu. Enter the IP address of the ESX Server and the root user's username and password. Note that this password is not going to be stored on the VirtualCenter Server. In production environments, a best practice is to create a new user account on the ESX Server host to support this connection. The connection process may take several minutes as VirtualCenter installs the VirtualCenter Agent on the ESX Server to enable ongoing management of the ESX Server. On the next screen, select to **Not enable VMotion** on this host. VMotion will be addressed later in this guide as an optional evaluation activity, as it can be configured at any time for this host via the host properties. Click **Finish** on the next screen to complete the Add Host wizard.

8. Note that you can now click on any of the inventory assets in the left Inventory Pane from the Farms to Hosts to virtual machines to view the status and properties and select from the available management actions. We are now ready to add and manage new virtual machines and will continue with that following the next chapter that introduces some new concepts useful for understanding the virtual infrastructure.
12 Understanding the Virtual Infrastructure

12.1 VirtualCenter Manages Virtual Machines Running on Physical Hosts

VirtualCenter monitors and manages various components of your virtual and physical infrastructure:

- **Virtual machines** — Virtualized x86 personal computer environments in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same managed host machine concurrently. Virtualization platforms are VMware products, such as ESX Server, GSX Server, or Workstation. These are used to create the virtual machines in the form of a set of configuration and disk files that together perform all the functions of a physical machine. Through the virtualization platform, you run the virtual machines, install operating systems and run applications, and configure the virtual machines.

- **Hosts** — The physical computers on which the virtualization platform software, such as ESX Server or GSX Server, is installed. These computers are added to the VirtualCenter environment to host virtual machines through the Add Host wizard. When VirtualCenter adds a host, it automatically discovers and registers all the virtual machines on that host. Each managed host is then associated with a specific farm.

- **Datastores** — Virtual machine disks are encapsulated into files, which in turn are stored on datastores. Virtual infrastructure’s ability to encapsulate disks into files simplifies storage management by hiding the differences between various storage options such as local storage, SAN and NAS.

12.2 CPU, Memory & Hardware Virtualization

The heart of virtualization is based on managing the execution of many virtual machines on a few processors. CPUs are virtualized when the ESX Server VMkernel hypervisor displaces the OS kernel from Ring 0 in the CPU to Ring 1. The VMkernel then dynamically schedules processing time for virtual machines and the Service Console. This virtualization of processors can take advantage of hyperthreading, multi-core and symmetric multi-processing CPUs.

This ability to share a pool of processors across multiple workloads allows applications from under-utilized servers to be safely consolidated onto a single server to safely achieve higher utilization.
Memory is virtualized next to dynamically provide each virtual machine with sufficient RAM to run efficiently. As with the CPUs, the advantage of virtualization is that all servers can be sized collectively for peak loads rather than individually, greatly increasing the resource utilization.

Two additional virtualization features help improve memory utilization for virtual machines: RAM over-commitment and transparent page sharing.

RAM over-commitment safely increases RAM utilization by allowing the sum of configured memory for all virtual machines to exceed the host’s physical memory. ESX Server handles this by using a pre-configured swap file for temporary storage if the memory demands from virtual machines exceed the availability of physical RAM on the host server. ESX Server lets virtual machines manage their own memory swap prioritization by using memory ballooning to dynamically shift memory from idle VMs to active VMs. Memory ballooning artificially induces memory pressure within idle VMs as needed, forcing them to use their own paging areas and release memory for more active or higher priority VMs. RAM over-commitment enables great flexibility in sharing physical memory across many virtual machines so that a subset can benefit from increased allocations of memory when needed.

Transparent page sharing conserves memory across virtual machines with similar guest operating systems by seeking out memory pages that are identical across multiple virtual machines and consolidating them so they are stored only once and shared.

The final components virtualized for sharing within host servers are the rest of the hardware devices. The VMkernel virtualizes the physical hardware and presents each virtual machine with a standardized virtual device. It is exactly this standardization that enables the encapsulation and portability benefits of virtualization.

The diagram on the right depicts the common standard components that are virtually available to every virtual machine based on dynamic mappings to physical hardware.
**Virtual Machine Specifications**
As a frame of reference for virtual machine capability and scalability, each ESX Server machine can host virtual machines concurrently using up to 80 virtual CPUs (and up to 200 registered virtual machines) on a single ESX Server, with the following capabilities and specifications:

<table>
<thead>
<tr>
<th>ESX Server Component</th>
<th>Virtual Capacity &amp; Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Storage</td>
<td>Up to 4 host bus adapters per virtual machine</td>
</tr>
<tr>
<td></td>
<td>Up to 15 targets per host bus adapter</td>
</tr>
<tr>
<td></td>
<td>Up to 60 targets per virtual machine; 256 targets concurrently in all virtual machines per ESX Server</td>
</tr>
<tr>
<td>Virtual Processor</td>
<td>Same as host system processor</td>
</tr>
<tr>
<td></td>
<td>One or two processors per virtual machine</td>
</tr>
<tr>
<td>Virtual Chip Set</td>
<td>Intel 440BX-based motherboard with NS338 SIO chip</td>
</tr>
<tr>
<td>Virtual BIOS</td>
<td>PhoenixBIOS™ 4.0 Release 6</td>
</tr>
<tr>
<td>Virtual Memory</td>
<td>Up to 3.6GB per virtual machine</td>
</tr>
<tr>
<td>Virtual SCSI Devices</td>
<td>Up to 4 virtual SCSI adapters per virtual machine with up to 15 devices per adapter</td>
</tr>
<tr>
<td></td>
<td>9TB per virtual disk</td>
</tr>
<tr>
<td>Virtual Ethernet Cards</td>
<td>Up to 4 virtual Ethernet adapters per virtual machine</td>
</tr>
<tr>
<td></td>
<td>Note: Each virtual machine has a total of 7 virtual PCI slots, so the total number of virtual adapters,</td>
</tr>
<tr>
<td></td>
<td>SCSI plus Ethernet, cannot be greater than 7.</td>
</tr>
<tr>
<td>Virtual Floppy Drives</td>
<td>Up to two 1.44MB floppy drives per virtual machine</td>
</tr>
<tr>
<td>Virtual CD-ROM</td>
<td>Up to two drives per virtual machine</td>
</tr>
<tr>
<td>Legacy Devices</td>
<td>Virtual machines may also make use of the following legacy devices. However, for performance reasons, use</td>
</tr>
<tr>
<td></td>
<td>of these devices is not recommended.</td>
</tr>
<tr>
<td></td>
<td>Virtual Serial (COM) Ports</td>
</tr>
<tr>
<td></td>
<td>- Up to two serial ports per virtual machine</td>
</tr>
<tr>
<td></td>
<td>Virtual Parallel (LPT) Ports</td>
</tr>
<tr>
<td></td>
<td>- One LPT port per virtual machine</td>
</tr>
</tbody>
</table>
## ESX Server Maximum Physical Machine Specifications

Below are the maximum physical machine specifications for an ESX Server to clarify how a single physical server can scale to up to 200 virtual servers:

<table>
<thead>
<tr>
<th>Maximum Server Specification</th>
<th>VMware ESX Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processors</td>
<td>16 physical processors per system with 8 virtual CPUs per processor</td>
</tr>
<tr>
<td></td>
<td>80 virtual CPUs in all virtual machines per ESX Server system</td>
</tr>
<tr>
<td>CPU Speed</td>
<td>Standard x86-based computer</td>
</tr>
<tr>
<td></td>
<td>Not constrained</td>
</tr>
<tr>
<td>RAM</td>
<td>64GB of RAM per ESX Server system</td>
</tr>
<tr>
<td></td>
<td>Up to 8 swap files with a maximum file size of 64GB per swap file</td>
</tr>
<tr>
<td>Storage</td>
<td>16 host bus adapters per ESX Server system</td>
</tr>
<tr>
<td></td>
<td>128 logical units (LUNs) per storage array</td>
</tr>
<tr>
<td></td>
<td>128 LUNs per ESX Server system</td>
</tr>
<tr>
<td></td>
<td>128 VMFS (VMware File System) volumes per ESX Server system</td>
</tr>
<tr>
<td></td>
<td>Maximum 32 physical extents per VMFS-2 volume with 2TB per physical extent</td>
</tr>
<tr>
<td></td>
<td>Maximum 27 TB size per VMFS-2 volume with a maximum of 2TB per each physical extent</td>
</tr>
<tr>
<td>Adapters</td>
<td>64 adapters of all types, including storage and network adapters, per system</td>
</tr>
<tr>
<td></td>
<td>Up to 8 Gigabit Ethernet or 16 10/100 Ethernet ports per system</td>
</tr>
<tr>
<td></td>
<td>Up to 32 virtual machines per virtual network device (vmnic or vmnet adapter)</td>
</tr>
</tbody>
</table>
### 12.3 Storage Virtualization

Storage virtualization is another key element to understand to support the architecture and deployment of virtual infrastructure. At the heart of virtualized storage management is the VMware Virtual Machine File System (VMFS). VMFS utilizes very simple and fast data structures optimized to support high performance disk access and large partition sizes up to 2 TB. VMFS volumes are used by ESX Server to store virtual disks, VMkernel swap files, suspended state files, REDO logs and VirtualCenter templates.

Two special attributes of VMFS make it an ideal storage format for SANs:
- VMFS is a multiple access file system that implements file level locking to allow multiple ESX Servers to access the same volume simultaneously over a SAN
- VMFS imposes minimal performance overhead as native SCSI commands are passed directly to the physical storage without the need for translation

In addition to being stored on local SCSI disks, virtual machines for ESX Servers can be located within VMFS partitions within LUNs a SAN. Virtual disks can also be mapped to a raw LUN on a SAN or to a raw SCSI device, and ESX Server is capable of booting directly from a SAN.

All storage is presented to virtual machines as SCSI disks, with the virtual machine seeing either an LSI Logic or a BusLogic SCSI Controller.

Virtualized storage also enables very flexible disk access modes. Most virtual machines will run in Persistent mode for normal read / write operations, but they can also use Undoable mode that sets the disks to read-only and creates a redo log that can later be committed or discarded. These flexible disk access modes are especially useful in development, testing and training environments.

Storage management with ESX Server is most powerful when used with SANs. SANs allow multiple physical machines to access the same storage LUNs, so multiple ESX Servers can see the same VMFS volumes for:
- Workload balancing via VMotion VM relocation
- Disaster recovery using common access
- High availability using clustered applications
- Rapid provisioning using a template repository

SANs can also provide all virtual machines with high availability storage. ESX Server provides multi-pathing in the virtualization layer to automatically allow the use of a different path to storage in the event that a Host Bus Adapter (HBA) or storage switch fails.
12.4 Network Virtualization

Network virtualization is the final area to clarify in the topic of virtualizing physical servers. Virtual networking is very similar to physical networking conceptually and in practice, but with many added benefits.

As depicted in the diagram to the right, operating systems running in virtual machines are assigned virtual NICs with their own MAC addresses that are bound to physical NICs for external traffic using virtual switches. A strong advantage of virtual networking is that these virtual machines can also be networked directly to other virtual machines running on the same ESX Server, and traffic on these internal virtual networks can be isolated so no traffic reaches the physical network. This opens the opportunity to create very high performing multi-tier application and firewall configurations of virtual machines running on a single physical server.

From a fault tolerance perspective, the virtualization layer supports NIC Teaming which enables the grouping of 2-10 physical NICs to create a highly redundant network device that can be used to support load balanced traffic transparently to all virtual machines on the system.

Virtual NICs also provide greater network security as virtual machines on the same virtual switch can be prevented from seeing each other’s traffic. You can also select to disallow MAC address changes and forged MAC transmits by the guest operating systems.

Virtual LANs also support VLAN tagging to allow the creation of multiple logical LANs within or across physical network segments. VLANs free network administrators from the limitations of a physical network configuration to improve security, improve performance and reduce cost.

The diagram below presents an example virtual networking scenario where database and application servers are securely protected behind a virtual firewall.
12.5 VirtualCenter Software Components

VMware VirtualCenter is designed to centrally monitor and manage all the VMware virtual machines and hosts in your enterprise virtual infrastructure. To perform these functions, VirtualCenter provides:

- **VirtualCenter Client** — A user interface that runs locally on a Windows machine. The VirtualCenter client runs on a machine with network access to the VirtualCenter server. This can be on the same machine as the VirtualCenter server or on another machine with network access.

- **VirtualCenter Server** — A service that acts as a central administrator for VMware ESX Server and GSX Server hosts connected on a network to direct actions upon the virtual machines and the virtual machine hosts. VirtualCenter server provides the central working core of VirtualCenter. VirtualCenter server is deployed as a Windows service and runs full-time. It must have network access to all the hosts it manages and be available for network access from any machine where the VirtualCenter client is run.

- **VirtualCenter Agent** — Installed on each managed host, it collects, communicates, and executes the actions received from the VirtualCenter server. It is installed automatically the first time any given host is added to the VirtualCenter inventory.

- **VMotion** — A feature that enables moving running virtual machines from one ESX Server to another without service interruption. The VirtualCenter server centrally coordinates all VMotion activities.

- **VirtualCenter Database** — A persistent storage area, for maintaining status of each virtual machine, host, and user managed in the VirtualCenter environment. This can be local or remote to the VirtualCenter server machine.

The figure below illustrates the relationships between the VirtualCenter installed components.
12.6 VirtualCenter Organizes Servers into Farms and Groups

A farm is the primary organizational structure used in VirtualCenter. A farm contains managed hosts and virtual machines. All actions taken upon managed hosts and virtual machines are applied within their farm. Within a farm, you can monitor and manage virtual machines separately from their hosts and use VMotion; you cannot perform migration between farms.

Server Farms and Groups assist in managing the complexity of the handling of potentially hundreds of virtual machines. They can be added, deleted, reorganized and renamed to represent their organization purposes; for example, they can be named after company departments or locations or functions. The organizational components are:

- **Server Farms** — The top-level structure for the VirtualCenter server. Only one Server Farms object exists for each VirtualCenter server. Server Farms can contain multiple farm groups and farms. The term Server Farms is the default value; the actual name used can be changed.

- **Farm Groups** — An optional grouping structure that is hierarchically contained within the Server Farms structure. The VirtualCenter server supports multiple farm groups. Farm groups can contain other farm groups and farms.

- **Farm** — The main structure under which hosts and their associated virtual machines are added to the VirtualCenter server. VirtualCenter server supports multiple farms. Note: A host can be managed by only one farm at a time. Note: All operations between hosts and virtual machines occur within a single farm. For example, hosts and virtual machines are not migrated between farms.

- **Virtual Machine Groups** — An optional grouping structure that is contained within a farm. VirtualCenter server supports multiple virtual machine groups. Virtual machine groups contain virtual machines and other virtual machine groups.

All the VirtualCenter components — the hosts, the virtual machines, and the organizational groupings of server farms, farms, and farm groups — are contained within the VirtualCenter environment. The figure below illustrates the hierarchy of the VirtualCenter organizational components.

When an ESX Server host is added to the inventory hierarchy, VirtualCenter automatically queries the host for any registered virtual machines and adds the virtual machines to the VirtualCenter inventory by including them in a "Discovered VMs" folder. This folder is simply a newly created virtual machine group that can be renamed. Virtual Machines can be added to and removed from this default virtual machine group.
12.7 VirtualCenter Manages Tasks, Templates, Alarms & Events

The functional components in VirtualCenter are groups comprised of the monitoring and managing tasks. The functional components are:

- **Inventory** — A view of all the monitored objects in VirtualCenter. Monitored objects include Server Farms, farms, farm groups, hosts, virtual machines, and virtual machine groups.

- **Scheduled Tasks** — A list of activities and a means to schedule those activities.

- **Templates** — A means to import virtual machines and store them as templates for deploying at a later time to create new virtual machines.

- **Alarms** — A component that allows you to create and modify a set of alarms that you define. Alarms are applied to an object and contain a triggering event and a notification method. Alarms do not have a navigation toolbar option. Alarms are viewed through the Alarms tab for each object.

- **Events** — A list of all the events that occur in the VirtualCenter environment. Use the Navigation option to display all the events. Use an object specific panel to display only the events relative to that object.

The figure below illustrates the relationship of the VirtualCenter functional components.
12.8 VirtualCenter Manages Access Privileges with Users & Groups

Each VirtualCenter user logs on to the VirtualCenter service through the VirtualCenter client. Each VirtualCenter user is identified to the VirtualCenter as someone who has assigned rights and privileges to selected objects, such as farms and virtual machines, within the VirtualCenter environment. VirtualCenter itself has full rights and privileges on all hosts and virtual machines within the VirtualCenter environment. VirtualCenter passes on only those actions and requests from a VirtualCenter user that the user has permission to perform. VirtualCenter grants access to each VirtualCenter object, farm, farm group, virtual machine, and virtual machine group. To do this, VirtualCenter assigns a role and a user (or group) to each object. Individual permissions are assigned through VirtualCenter by pairing a user and a role and assigning this pair to a VirtualCenter object.

- **Users and Groups** — Created through the Windows domain or Active Directory database. VirtualCenter registers users and groups as part of the assigning privileges process.

- **Roles** — A set of access rights and privileges predefined by VirtualCenter.

There are four roles. Each role includes the privileges of lower level roles. The types of roles that can be paired with a user and assigned to an object are:

- **VirtualCenter Administrator** — Users in this role are allowed to change privileges for an object. With this role, you can add, remove, and set access rights and privileges for all the VirtualCenter users and all the virtual objects in the VirtualCenter environment.

- **Virtual Machine Administrator** — Users assigned this role for an object are allowed to add, remove, or modify objects. With this role, you can:
  - Connect/disconnect managed hosts, migrate, and migrate with VMotion, clone, remove, and configure virtual machines.
  - Create, import, and deploy templates.
  - Add and remove hosts from farms.
  - Create, remove, or modify farms, farm groups, and virtual machine groups and their content.

- **Virtual Machine User** — Users assigned this role for an object are allowed to perform power operations on virtual machines. With this role, you can connect with a remote console and view the states of virtual machines. You cannot modify the configuration of hosts or virtual machines.

- **Read Only User** — Users assigned this role for an object are allowed to view the state of virtual machines, hosts, farms, and groups. With this role, you can view virtual machines, hosts, farms, farm groups, and virtual machine group attributes, that is, all the tab panels in VirtualCenter except the Console tab. You cannot view the remote console for a managed host. All actions through the menus and toolbars are disallowed. A user with Read-Only User role access can view the templates and scheduled tasks but not perform any actions with them.
12.9 Working with the VirtualCenter Client

The VirtualCenter client display is a typical Windows screen. It contains a menu bar, a shortcut navigation bar, a navigation specific toolbar, and a display area. The VirtualCenter client is basically divided into two areas:

- A **heading area** with a main menu, navigation bar, and toolbar.
- A **data area** that changes depending upon the selection in the navigation bar.

The navigation bar options divide the primary tasks of VirtualCenter into:

- **Inventory** — Divided into two sub panels, the inventory panel and the information panel. This navigation bar option displays all the objects contained within VirtualCenter.
- **Scheduled Tasks** — Displays an information panel that lists all the tasks scheduled to occur.
- **Templates** — Displays an information panel that lists all the templates available for deploying. This list includes templates that are stored in the template upload directory, stored on a local disk, or stored on the same datastore as their source virtual machine.
- **Events** — Displays an information panel that lists all the events that have occurred in the VirtualCenter.

Click on the navigation bar buttons to familiarize yourself with their contents. Back in the Inventory pane, go ahead and select VirtualCenter objects such as farms, groups, hosts, and virtual machines to monitor the status of the object and right-click them to access action menus. This will give you an overview of the context sensitive options available for each.
Below is a summary view and description of the monitoring tabs available for farm, farm group, host server and virtual machine inventory objects:

<table>
<thead>
<tr>
<th>Tabs Available</th>
<th>For VC Farm &amp; Farm Groups</th>
<th>For a Farm</th>
<th>For a Host Server</th>
<th>For a Virtual Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Farms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual Machines</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hosts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tasks</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Events</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Permissions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Console</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**VC Farm & Farm Groups**
- Farms – Displays all farm groups available on the VirtualCenter Server
- Virtual Machines – Displays all virtual machines available on the VirtualCenter Server
- Hosts – Displays all physical ESX and GSX Host Servers on the Virtual Center Server
- Tasks – Displays all current tasks on the VirtualCenter Server
- Events – Displays all current events on the VirtualCenter Server
- Alarms – Displays all current alarms on the VirtualCenter Server
- Permissions – Displays all permissions at the VirtualCenter Server level

**Farm**
- Summary – Displays a summary view of the Farm’s hosts, VMs and performance
- Virtual Machines – Displays a list of all virtual machines in the Farm
- Hosts – Displays a list of all physical ESX and GSX Host Servers on the Farm
- Performance – Displays the average CPU, memory, disk and network performance for the Farm
- Tasks – Displays all current tasks on the Farm
- Events – Displays all current events on the Farm
- Alarms – Displays all current alarms on the Farm
- Permissions – Displays all permissions at the Farm Level

**Host Server**
- Summary – Displays a summary view of the Host Server’s properties and performance
- Virtual Machines – Displays a list of all virtual machines on the Host Server
- Performance – Displays the current CPU, memory, disk and network performance for the Host Server
- Tasks – Displays all current tasks on the Host Server
- Events – Displays all current events on the Host Server
- Alarms – Displays all current alarms on the Host Server
- Permissions – Displays all permissions at the Host Server level

**Virtual Machines**
- Summary – Displays a summary view of the virtual machine’s properties and performance
- Performance – Displays the current CPU, memory, disk and network performance for the virtual machine
- Tasks – Displays all current tasks on the virtual machine
- Events – Displays all current events on the virtual machine
- Alarms – Displays all current alarms on the virtual machine
- Console – Displays the current screen of the virtual machine and enables all keyboard and mouse input
- Permissions – Displays all permissions at the virtual machine level
12.10 Common Actions Performed Through VirtualCenter

Typical VirtualCenter operations are focused around managing virtual machines on multiple hosts. Performing an action through VirtualCenter involves:

- Starting and logging on to the VirtualCenter client.
- Adding or selecting a virtual machine, host, farm, or group.
- Selecting the desired action from the corresponding menu for the virtual machine, host, farm, or group, and answering the prompts from the task wizard screens.

The figure below illustrates the process flow for typical VirtualCenter activities.
13 Creating New Virtual Machines

There are two methods for adding virtual machines to VirtualCenter; either register a host with existing virtual machines on it, or create new virtual machines on existing hosts. The list below describes some of the key process options for creating new virtual machines.

- A virtual machine can be created from scratch using the New Virtual Machine Wizard. After creating a virtual machine, you must install a guest operating system.
- An existing virtual machine can be cloned to create new virtual machines using the Clone Wizard.
- An existing virtual machine can be used as a source for new templates using the New Template Wizard.
- An existing physical machine can be cloned to create a duplicate virtual machine using VMware P2V Assistant.

13.1 Creating New Virtual Machines from Scratch

Through the New Virtual Machine Wizard and the Virtual Machine Properties dialog box, you can create new virtual machines from scratch and make configuration modifications to them once they are created. New virtual machines are added to managed hosts. You must select a managed host to be able to start the New Virtual Machine Wizard.

To create a new virtual machine through the typical path in the New Virtual Machine Wizard:

1. From the VirtualCenter client, display the inventory panel. Click Inventory in the navigation bar. Expand the inventory as needed. Select a managed host and start the New Virtual Machine Wizard by right clicking on the host and selecting New Virtual Machine.

2. In the inventory list, select the managed host to which to add the new virtual machine. Choose File > New > Virtual Machine, and then click Next.

3. Select whether to use a Typical configuration or Custom configuration. Select Typical and click Next. Using a typical installation, you can specify or accept defaults only for:
   a. The group for the virtual machine.
   b. The guest operating system.
   c. The virtual machine name and the location of the virtual machine’s files.
   d. The network connection type.
   e. The size of the virtual disk.

   For future reference, a Custom Installation additionally allows you to specify the following:
   a. Specify the number of virtual processors for the virtual machine.
   b. Allocate an amount of memory different from the default.
   c. Choose between the LSI Logic and BusLogic types of SCSI adapters. (An ATAPI IDE adapter is always installed.)
   d. Use an existing virtual disk.
   e. Directly access a system LUN instead of using a virtual disk.
   f. Specify a particular virtual device node for the virtual disk.
   g. Choose a mode for the virtual disk.
4. Select a group location for the new virtual machine. Click Next.

5. Under Guest operating system, select the operating system family (Microsoft Windows, Linux, Novell NetWare or Other), then select the specific operating system from the Version list. VirtualCenter does not install the Guest Operating System for you; your selection here is used only to select appropriate default configuration parameters for the virtual machine. This screen asks which operating system you plan to install in the virtual machine. The New Virtual Machine Wizard uses this information to select appropriate default values, such as the amount of memory needed. The wizard also uses this information when naming associated virtual machine files. Click Next to continue.

6. Specify a name for the virtual machine and datastore volume for the virtual disks.
   a. Enter the Virtual machine name to use. The name you enter in the Virtual Machine Name field is the name that is listed in the VirtualCenter client inventory, and in other areas, such as the VMware Management Interface. It is also used as the name of the virtual machine’s files. Enter a useful name. The name can be up to 80 characters long and contain alphanumeric characters and the underscore (_) and hyphen (-) characters. It should also be unique across all virtual machines. Be sure that the virtual machine name is unique as duplicate names cause confusion and are not allowed within a virtual machine group. A best practice is to create virtual machines using the same name for the vmx file, the vmdk file, the display name and even the actual guest OS host name for consistency.
   b. Select the Datastore on the managed host to use for storing the virtual disk files. For ESX Server hosts, the names listed under datastores are the configured VMFS volumes for that managed host.
   c. Click Next to continue.
7. Specify the networking settings for the virtual machine.
   a. Select the virtual network name to use from the NIC list.
   b. Select the network adapter type for the virtual machine. Select either the defaultvlan adapter or the vmxnet adapter if the guest operating system will be Windows Server 2003, Windows XP or Windows 2000. The vmxnet driver provides higher performance, especially with gigabit adapters.
   c. If you do not want the virtual network adapter to connect when the virtual machine is powered on, clear the Connect at power on check box.
   d. If you do not want the virtual machine to have a connection to the network, select the Do not use a network connection check box.
   e. Click Next to continue.

8. Specify the size of the virtual disk. Enter the disk size in Gigabytes (GB). The default is 4GB. Your virtual disk can be as small as 0.1GB (100MB). A SCSI virtual disk can be as large as 2TB on an ESX Server host. For ESX Server hosts, the available space on the selected VMFS volume is listed. The virtual disk should be large enough to hold the guest operating system and all of the software that you intend to install, with room for data and growth. For example, you need about 1GB of actual free space on the file system containing the virtual disk to install Windows Server 2003 and applications such as Microsoft Office inside the virtual machine. It is possible to later enlarge the size of existing virtual disks using vmkfstools, but it is much easier to size them sufficiently at creation. You can also always install additional virtual disks later by using the Virtual Machine Properties dialog box.

9. Click Next and then click Finish. Before you can use your new virtual machine, you need to partition and format the virtual disk, then install a guest operating system and VMware Tools. The operating system's installation program may handle the partitioning and formatting steps for you.
Installing a Guest Operating System
After you create a virtual machine, you must install an operating system on its virtual disk just as you do on a new physical machine. You use a standard installation CD-ROM and format the virtual disk at the appropriate place in the installation process. As a faster and more convenient alternative, you can install an operating system from ISO image files of installation CD-ROMs. Once you start the virtual machine, the normal operating system installation takes over. Answer the prompts that appear on the virtual machine console to install the guest operating system.

To access the virtual machine to install a guest operating system, use the virtual machine console, found on the Console tab for the Inventory button in the navigation bar. Choose an installation method:

- **Install from CD-ROM** – Configure the virtual machine to connect to the physical ESX Server CD-ROM and boot an operating system installation disk from it.
- **Install from ISO Image** – Configure the virtual machine CD-ROM as a path to a local or networked ISO file and boot from that. A virtual CD-ROM drive is automatically created when you create a new virtual machine. If you are planning to install the guest operating system from an ISO image, use the Virtual Machine Properties dialog box to map the virtual CD-ROM drive to the ISO image before powering on the virtual machine.

To install the guest operating system via a CD-ROM drive:

1. Insert the installation CD-ROM for your guest operating system in the ESX Server CD-ROM drive.
2. Click **Power On** on the remote console toolbar and switch to the Console tab to begin setting up your guest operating system.

To install the guest operating system from a local or network ISO image:

1. Prepare ISO image files of installation CD-ROMs needed for the installation.
2. Right-click on the virtual machine and select **Properties** to edit the virtual machines properties. Select the CD-ROM device and click **Browse** to connect the virtual machine’s CD-ROM drive to the appropriate ISO image file. You will need to access the images from the network or copy the ISO image onto the ESX Server into the vmimages directory or a user’s home directory to browse to it. Click **OK** to save the changes.
3. Once the installation media is successfully mapped, click **Power On** on the remote console toolbar and switch to the Console tab to begin setting up your guest operating system.

Soon after the system starts, click in the console to give it focus and press **F2** when prompted to enter the system BIOS. Move to the **Boot** tab, select the **CD-ROM Drive** and press **+** to move it to the top of the boot order. This will enable the system to find the operating system on the CD-ROM disk or image mapping. Press **F10** to save and exit. The system will reboot.
Note that when you are installing a guest operating system on a new virtual disk, you may see a message warning you that the disk is corrupted and asking if you want to place a partition table on the disk. This message does not mean there is any problem with your physical hard disk. It simply means some data needs to be written to the file that holds your virtual hard disk. All you need to do is respond Yes. You also need to partition and format the virtual disk as you would with a new, blank hard drive.

**Installing VMware Tools**

VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating system and improves management of the virtual machine. It is very important that you install VMware Tools in the guest operating system. Although the guest operating system can run without VMware Tools, you lose important functionality and convenience.

When you install VMware Tools, you install the following components:

- The VMware Tools service (or vmware-guestosd on Linux guests).
- A set of VMware device drivers, including an SVGA display driver, the vmxnet networking driver for some guest operating systems, the BusLogic SCSI driver for some guest operating systems and the VMware mouse driver.
- The VMware Tools control panel that lets you modify settings, shrink virtual disks, and connect and disconnect virtual devices.
- A set of scripts that help automate guest operating system operations; the scripts run when the virtual machine’s power state changes.
- A component that supports copying and pasting text between the guest and managed host operating systems.

To install VMware Tools in a virtual machine, right-click on the virtual machine in the inventory panel and select to **Install VMware Tools**.

Note that when working with virtual machines, if the networks adapters don’t appear to be set to the correct speed / duplex setting or appear to be running slowly, refer to the following Knowledge Base article 813 for a resolution: [http://www.vmware.com/support/kb/enduser/std_adp.php?p_sid=9uhecM&Mh&v_ha=a&f_faqid=813](http://www.vmware.com/support/kb/enduser/std_adp.php?p_sid=9uhecM&Mh&v_ha=a&f_faqid=813)
13.2 Creating New Virtual Machines from Existing Servers

VMware P2V Assistant

One alternative to rebuilding test systems from scratch to support the evaluation is to register for an evaluation copy of the VMware P2V Assistant, an enterprise-class migration tool that transforms an image of an existing physical system into a VMware virtual machine. This easy to use market proven tool enables fast and reliable physical to virtual machine migration for Microsoft Windows operating systems ranging from Windows NT 4 to Windows Server 2003.

VMware P2V Assistant takes a snapshot of an existing physical system and transforms it into a VMware virtual machine, eliminating the need to reinstall and reconfigure complex application environments. P2V Assistant performs all necessary substitutions to transform a physical system into a production-ready virtual machine, by guiding the administrator through an easy to use GUI wizard:

- Creates an image of the source machine with built-in imaging or 3rd party imaging tool
- Performs all necessary disk controller and driver substitutions so the virtual machine can be booted
- Recommends additional configuration modifications to make the new virtual machine production ready

Virtual machines created by the P2V Assistant will run on VMware ESX Server, VMware GSX Server and VMware Workstation.

VMware customers are most commonly using P2V Assistant to support the following:

- Fast and clean migrations of existing applications to VMware virtual machines without requiring a re-install or rebuild to enable migration to virtual infrastructure
- Efficient QA & Debugging by cloning production systems into QA and testing environments
- Disaster Recovery and Backup to periodically capture production systems into a library that can be deployed in the event of a disaster

VMware Technology Network (VMTN) Templates of Pre-Configured Virtual Machines

An additional source of virtual machines for evaluation purposes is the VMware Technology Network (VMTN) Subscription, a service for developers and testers that bundles access to VMware products, support and upgrades in a convenient, low-cost annual subscription. As part of the developer support program, VMTN provides a collection of pre-built virtual machines from industry-leading ISV and open source partners that simplifies software packaging, distribution, and deployment. Instead of spending time installing and configuring applications, developers and QA teams can now focus their efforts on development and testing. To run a new application, simply download a virtual machine with the application software pre-installed and configured, and run it in VMware Workstation, GSX Server or ESX Server.

Some of these pre-configured virtual machines are available from VMware ISV partners without requiring an annual subscription to VMTN. For example, you can find pointers to various Linux virtual machines pre-loaded with Oracle, BEA, MySQL, etc. at http://www.vmware.com/vcommunity/technology/vm/. In most cases, a simple registration with the provider of the VM is all that is necessary to download these pre-configured virtual machine images for evaluation and testing purposes.
13.3 Creating, Storing and Deploying Virtual Machine Templates

Once virtual machines have been created and configured as golden images, they can be packaged as templates and stored either locally on ESX Servers or centrally within a VirtualCenter template repository to support the rapid provisioning of new virtual machines.

Templates are created from existing virtual machines. These virtual machines can be either:
- Virtual machines located on a VirtualCenter managed host.
- Unmanaged virtual machines stored on a disk local to the VirtualCenter server.

When you create a template, VirtualCenter provides an option to store the template at one of two locations:

- **Datastore** — Any datastore accessible to the managed host (local or networked) where the source virtual machine resides. This option works best with a shared datastore between hosts on a farm. This option is typically used for creating templates from virtual machines on registered hosts.

- **Template upload directory** — Located on the VirtualCenter server machine, the upload directory contains copies of the original virtual machine virtual disks. Specify a directory local to the VirtualCenter server as the template upload directory. This option is used when a template might need to be deployed to any managed host.

The figure below illustrates the two methods for storing templates in VirtualCenter.
Deploying a Virtual Machine from a Template
When you deploy a template, you create a new virtual machine from the template. The virtual machine can be placed on any host that has local access or network visibility of the template. The figure below illustrates the process for deploying a template to create a new virtual machine.
13.3.1 Creating Templates from Existing Virtual Machines

Before creating a template that will be used as the foundation for many other virtual machines, a recommendation is to modify the base image to use vmxnet, the high performance virtual network adapter, if the guest operating system is Windows Server 2003, Windows XP or Windows 2000. To do this:

1. Shutdown your base image virtual machine if it is running.

2. Within the VirtualCenter client, open the virtual machine’s properties and select NIC 1 on the Hardware tab. Change the Adapter type from vIance to vmxnet. Click OK to close the properties window.

3. Power on the virtual machine and login as Administrator from the console tab to complete the installation by walking through the Find New Hardware Wizard.

4. Shutdown the virtual machine.

To create a template from a virtual machine:

1. Start VirtualCenter client and log on to the VirtualCenter server.

2. From the inventory panel, click the Inventory button in the navigation bar. The inventory panel and the information panel display information about managed farms, hosts, and virtual machines. The Inventory toolbar appears.

3. Expand the inventory as needed and right-click on the desired virtual machine and select New Template from this Virtual Machine to start the New Template Wizard. The virtual machine has to be powered off for this option to be enabled. Click Next to continue.

4. Give the new template a Name and Description. Enter a useful name and a brief description of the template. This description can include the operating system, applications, versions, and intended uses for the template. The name can be up to 80 characters long and contain alphanumeric characters and the underscore (_) and hyphen (-) characters. The name should be unique across all templates and cannot start with a space or contain a back slash (\) or forward slash (/). Click Next.
5. Specify the target **Location of the Template Files**. The choices are:
   a. **On the VMware VirtualCenter server** — This option makes copies of the virtual machine disk files and places copies into the VirtualCenter upload directory. Copying the files can take some time. After the importing template process, the source virtual machine is available for normal operations. Use this option if the source disk is not on a SAN. This option ensures the template can be deployed to any managed host.
   b. **On a datastore** — This option adds a reference to the location of the files. The virtual machine disks are copied to the VMFS volume that you specify. Use this option when the virtual disk resides in a VMFS volume on a SAN. This ensures a rapid deployment of a new virtual machine because it is a local disk copy.
   c. The evaluation recommendation is to place the template in the `vmimages` or `home` volume of the local datastore.

6. Select the datastore location in which to place the new template. Click **Next**.

7. Complete the importing template process. Click **Finish**. VirtualCenter adds the configuration file data into the VirtualCenter database and adds the template to the list of available templates. Click on the **Tasks** tab to monitor the progress as the template is created. To view the list of created templates, click the **Templates** option in the navigation bar.

Note that template can be created from any VMware virtual machine, so all guest operating systems supported by VMware including many versions of Windows, Linux, Novell Netware and FreeBSD can be managed using templates.
13.3.2 Preparing for Guest Operating System Customization

When you deploy a template or clone an existing virtual machine, you have the opportunity to customize the new guest operating system. A Guest Customization wizard guides you through the configuration options to configure the machine as a unique new system. You need to use a Virtual Machine Administrator role assigned to the target host where the virtual machine is located to perform these activities.

Customizing Windows guest operating system options include:
- Join workgroups and domains
- Network interface configuration
- Domain suffix, security ID (SID) change

Customizing Linux guest operating system options include:
- Host name
- Domain suffix
- Network interface configuration

These evaluation steps cover the customization requirements, preparation and process for customizing Windows guest operating systems. Please refer to the VirtualCenter User’s Guide on pages 52, 324 and 328 for similar instructions covering Linux customization.

Virtual Hardware Requirements for Guest Customization

Before you run the Guest Customization wizard, that means, before you start the Template Deployment or Clone wizards, if you intend to perform a Guest Customization, perform the following:
- Verify that your system meets the guest customization requirements listed below.
- Install the required components described below on the Windows machine where the VirtualCenter server is installed. Note that after deploying and customizing non-volume-licensed versions of Windows XP or Windows 2003, it may be necessary to re-activate your Microsoft operating system on the new virtual machine.

Guest customization requires that the source virtual machine used to create the clone or templates has the following:
- VMware Tools installed.
- At least one Network Interface Card (NIC) configured. When a virtual machine is cloned or used for a template, the new virtual machine has the exact same number and type of NICs, for example, AMD Vlance / PcNet versus high-performance VMware vmxnet. This cannot be changed during the deployment or guest customization process.
- SCSI disks. The default configuration for VMware Workstation and GSX Server creating a Windows XP or Windows Server 2003 virtual machine is IDE disks. If you are customizing a virtual machine with IDE disks, it can only be deployed to a GSX Server host. VirtualCenter customization operates on the disk attached to the virtual SCSI node with the lowest address on the SCSI controller with the lowest index. As a result, you must make sure that the guest operating system being customized resides on a disk attached as SCSI 0:0 node in the virtual machine configuration. Note that if a virtual machine has mixed IDE and SCSI disks, the first IDE disk is considered the boot disk, and VirtualCenter passes it to the customizer. “First” is in controller:device order, that is, ide0:0, ide0:1, scsi0:0, scsi0:1, and so on.

For Windows guest operating systems: Both the active partition (the partition containing boot.ini) and the system partition (the partition containing the system directory, for example, WINNT or WINDOWS), are on the same virtual disk and attached the SCSI 0:0 virtual SCSI node. Note that it is not a requirement that active and system partitions be the same partition.

Windows Requirements for Guest Customization

Guest customization of a Windows guest operating system can occur if:
- The guest operating system is not a primary or backup domain controller.
- The clone or template has one of the following Windows versions installed:
  - Windows 2000 Server or Advanced Server
  - Windows XP Professional
  - Windows Server 2003, Web, Standard, or Enterprise Editions. Note that Windows XP Home or Windows NT4 operating system guest customization is not supported.
  - The Microsoft Sysprep tools are installed on the VirtualCenter server.
Installing the Microsoft Sysprep Tools
If you plan to customize a Windows guest operating system, you must first install the Microsoft Sysprep tools on your VirtualCenter server machine. Microsoft includes the Sysprep tool set on the installation CDs for Windows 2000, Windows XP, and Windows 2003. It also distributes Sysprep 1.1 from the Microsoft web site. In order to perform a Windows customization, you must install the Sysprep tools either from your installation CD, or from the 1.1 download package. During a customization, VirtualCenter searches for the Sysprep package corresponding to your guest operating system. If the Sysprep tools are not found under the corresponding provided operating system directory, VirtualCenter searches in the provided \1.1 directory. If VirtualCenter does not find any Sysprep tools, the Windows virtual machine customization does not proceed.

3. Click Next to continue. Click I agree to accept the terms and conditions. Click Download. Save the file to your local disk. Run the Microsoft installer Q257813\_w2k\_spl\_x86\_en.exe.
4. Extract the files to the provided directory. Sysprep support directories were created during VirtualCenter installation:

   C:\[VirtualCenter\_installation\_directory]\resources\windows\sysprep\                  ...esources\windows\sysprep\1.1\                  ...esources\windows\sysprep\2k\                  ...esources\windows\sysprep\xp\                  ...esources\windows\sysprep\svr2003\

5. Select the 1.1 subdirectory. Click OK to expand the files. After you have extracted the files from Q257813\_w2k\_spl\_x86\_en.exe to the \1.1 directory, you should see:

   ...esources\windows\sysprep\1.1\docs\                  ...esources\windows\sysprep\1.1\samples\                  ...esources\windows\sysprep\1.1\tools\                  ...esources\windows\sysprep\1.1\contents.txt

To install the Microsoft Sysprep tools from the Windows operating system CD:

1. Insert the Windows OS CD into the CD-ROM, for example, D: drive.
2. Locate the DEPLOY.CAB file in the CD directory, \Support\Tools.
3. Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another tool capable of reading Microsoft CAB files.
4. Extract the files to the provided directory appropriate to your Sysprep guest operating system. Sysprep support directories were created during VirtualCenter installation:

   C:\[VirtualCenter\_installation\_directory]\resources\windows\sysprep\                  ...esources\windows\sysprep\1.1\                  ...esources\windows\sysprep\2k\                  ...esources\windows\sysprep\xp\                  ...esources\windows\sysprep\svr2003\

   Select the subdirectory that corresponds to your operating system.

5. Click OK to expand the files. After you have extracted the files from DEPLOY.CAB, you should see:

   ...esources\windows\sysprep\<guest>\deptool.chm                  ...esources\windows\sysprep\<guest>\readme.txt                  ...esources\windows\sysprep\<guest>\setupcl.exe                  ...esources\windows\sysprep\<guest>\setupmgr.exe                  ...esources\windows\sysprep\<guest>\setupmgx.dll                  ...esources\windows\sysprep\<guest>\sysprep.exe                  ...esources\windows\sysprep\<guest>\unattend.doc

   where <guest> is either 2k, xp, or svr2003.

6. Repeat this procedure to extract Sysprep files for each of the Windows guest operating system (Windows 2000, Windows XP, or Windows 2003) you plan to customize using Virtual Center. You are now ready to customize a new virtual machine with a supported Windows guest operating system when you clone an existing virtual machine or deploy a template.
13.3.3 Deploying Templates to Create New Virtual Machines

To manually start the Template Deployment Wizard:

1. Start VirtualCenter and log on to the VirtualCenter server. From the inventory panel, right-click on the host where you want to deploy the template and select to Deploy Virtual Machine from Template to start the wizard. Click Next to confirm the start of the deployment wizard.

2. Select which template to deploy for this virtual machine and click Next.

3. Specify the new Virtual Machine Name. Click Next. Note that the virtual machine name cannot exceed 80 characters.
4. Select the farm or virtual machine group on which to deploy the new virtual machine. Click Next.

5. Select the datastore on which to store the new virtual machine configuration file and virtual disks. Click Next. This specifies the location for the virtual machine configuration and disk files. The virtual machine must be placed on a datastore. Select from the list.

6. Select the network interface card (NIC) to use for the virtual machine. Click Next.
7. Specify a resource allocation level. Click **Next**.

8. Select to **Start the guest customization wizard** to open the customization wizard. Note that you can also pre-configure import customization settings from an XML file with customization already defined. Refer to the section on Customizing a Windows Guest Operating System on page 71 for instructions performing guest customization.

9. Complete the Template Deployment Wizard. Click **Finish**. VirtualCenter displays the Tasks inventory panel for reference, makes a copy of the template, applies changes as specified, and stores the new virtual machine on the designated host location.
13.3.4 Customizing a Windows Guest Operating System

The customizing process varies, depending upon the guest operating system to be used in the new virtual machine. To customize a Windows 2000, Windows XP Professional, or Windows Server 2003 guest operating system while deploying a template or cloning a virtual machine, perform the following.

To customize a Windows guest operating system:

1. Start the Guest Customization wizard. You cannot start the Guest Customization wizard from a menu or toolbar option. The Guest Customization wizard starts indirectly from the VirtualCenter Template Deployment or Clone Wizard.

2. Confirm continuing with the Guest Customization wizard. Click Next.

3. Optionally, specify registration information. The owner’s Name and Organization are for your reference purposes only. They do not affect the functioning of the virtual machine. Enter the name of a person, user, or group, and of the organization in the appropriate fields. Click Next.

4. Specify a Computer Name for the virtual machine. The host or computer name is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Windows systems, it is called the computer name. On most other operating systems, it is called the host name. This is not the same as the virtual machine name that was declared earlier in the Clone or Template Deployment Wizard. If an asterisk (*) is entered in the Computer Name field, a random name is assigned to the computer name. When you specify a name, use only characters that are allowed in a Windows computer name. Click Next.

5. Provide the licensing information. Enter the Windows license key for the new guest operating system. For Windows Server operating systems, click the appropriate license mode and specify the maximum number of simultaneous connections allowed, if appropriate. Click Next.
6. Specify the password for the Administrator account.
   a. Enter the **Password** for the Administrative user. Enter it again in the **Confirm password** field.
   b. Optionally, click the box to automatically log on as administrator when the virtual machine boots. If this option is selected, also specify how many times the automatic logon is to be performed. This is useful if you know you will have a series of reboots before the virtual machine is ready for normal log on users.
   c. Click **Next**. Note that if you specify a new administrator password and the source Windows virtual machine or template already has one, then you must select the **Delete all user accounts** option in step 12. Otherwise the old administrator password is not changed.

7. Specify a time zone. Click **Next**.

8. Specify any commands to be run the first time the new virtual machine is started. To add commands, type the command string in the field and click **Add**. Use the **Delete** and **Move** options to position the commands in the appropriate order.
9. Select whether or not to use typical or customize network settings. Click **Next**. The options are:
   a. **Typical settings** — VirtualCenter automatically configures all network interfaces from a DHCP server.
   b. **Custom settings** — You specify the network settings.

10. If you use custom network settings:
   a. Select the network interface card (NIC) to customize. Click **Next**.
   b. Optionally, select the NIC, then click **Customize** to make additional specifications.
   c. If you are customizing the NIC network properties, select the method and enter the **IP** and **DNS** server addresses. Specify an IP address and DNS server. Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** in the Network Guest Customizations dialog box.
   d. Click the **DNS** tab to specify the DNS connections. Enter a new DNS suffix. Click **Add**. If you are adding multiple DNS addresses, use the **Move Up** and **Move Down** buttons to set the order of use. Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** in the Network Guest Customizations dialog box.
   e. Click on the **WINS** tab to specify the WINS address. Type the appropriate IP addresses. Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** on the Network Guest Customizations dialog box.

11. Join a workgroup or domain as desired. Enter the workgroup and domain identification information. Click **Next**.
12. Select additional guest operating system options. The options are:
   a. **Generate New Security ID (SID)** — This option is set to default.
   b. **Delete all user accounts** — If you specify a new administrator password in step 6 and the source Windows virtual machine or template already has one, then you must select the Delete all user accounts option here; otherwise, the old administrator password is not changed. This option is only available in the customization wizard for Windows 2000 guest operating systems.

   Click the buttons to configure any desired options. Click **Next**.

13. Optionally, save the customized options as an .xml file. Specify a filename and location. Click **Next**. VirtualCenter saves the customized configuration parameters in an .xml file. Later, import these predefined customized parameters, when deploying a template or cloning an existing virtual machine. If the customization settings are saved to a file then the administrator password of the Windows virtual machine and the domain administrator’s password, as applicable, are stored in encrypted format in the .xml file. Note that saved customization files are unique to each VirtualCenter server and to each version of VirtualCenter due to encryption. You have to recreate the customization files for each VirtualCenter server. Encryption is preserved between upgrade versions on the same VirtualCenter server. This means you can use the same files between upgrades of VirtualCenter. However if you perform an uninstall and a later fresh install, the ability to decrypt passwords from the earlier installation is lost. To recreate the customized parameters .xml files, use the Import customizations from an XML file option in the Deploy Template wizard. Click **Start the guest customization wizard** and modify the entry for the passwords and the administrator passwords again.

   Complete the Guest Customization wizard. Click **Finish**. VirtualCenter closes the Guest Customization wizard and returns you to the Deploy a Template or Clone a Virtual Machine wizard, click **Finish**.
13.4 Cloning Virtual Machines

A clone is a copy plus customization of a virtual machine. When you create a clone, VirtualCenter provides an option to customize the guest operating system of that virtual machine. Store clones on any managed host within the same farm as the original virtual machine.

The figure below illustrates the process for cloning an existing virtual machine to create a new virtual machine.
To manually start the Virtual Machine Cloning wizard:

1. Start VirtualCenter and log on to the VirtualCenter server.

2. Start the Clone a Virtual Machine wizard, from the inventory panel:
   a. Click the Inventory button in the navigation bar. The inventory panel and the information panel display the managed farms, hosts, and virtual machine information. The Inventory toolbar appears.
   b. Expand the inventory as needed, and click the source virtual machine.
   c. Start the **Clone this Virtual Machine wizard**. From the main or right-click popup menu, select **Clone**.

3. Confirm continuing with the Clone Wizard. Click **Next**.

4. Select a target host for the clone. Click **Next**.

5. Select a Virtual Machine Group for the clone. Click **Next**.
6. Assign a name to the clone. Enter a name. Click **Next**.

7. Select the datastore location. Select a location from list. Click **Next**.

8. Assign the network interface cards (NIC). Select from the list, if there is more than one NIC. Click **Next**.
9. Specify the resource allocation level. The resource allocating level tells VirtualCenter what percentage of the host resources to make available to the new virtual machine. Click the appropriate radio button. Click Next.

10. Select whether or not to customize the new virtual machine as you create it. Click the appropriate radio button. Click Next. If you select the customization option, refer to Customizing a Windows Guest Operating System on page 71 for a description of the customization wizard and options. If you decide not to customize the new virtual machine as part of the cloning process, proceed to the next step.

11. Complete the Cloning a Virtual Machine wizard. Click Finish. VirtualCenter displays the Scheduled Tasks panel for reference and makes a copy of the virtual machine, applies changes as specified, and stores the virtual machine on the designated host location.
14 Managing Virtual Machines

14.1 Starting, Stopping, Suspending & Resetting Virtual Machines
Virtual machines can be configured to start automatically when the host server starts up or they can be manually started when needed. Virtual machines can be started, stopped, suspended and reset from the toolbar in VirtualCenter or from the summary tab for the virtual machine.

Suspending a virtual machine pauses its operation and saves the current state. Resetting a virtual machine causes it to shutdown and restart.

14.2 Editing Virtual Machine Configurations
In addition to customizing a virtual machine while you create it, you have the option to edit the virtual machine configuration after you create it. Refer to your VMware ESX Server VirtualCenter documentation for information about all the ramifications of specific customizations.

To edit an existing virtual machine configuration:

1. From the VirtualCenter client, display the inventory panel and expand the appropriate farm. Click Inventory in the navigation bar. Expand the inventory as needed, and click the virtual machine to customize.

2. Power off the virtual machine. You cannot edit most virtual machine properties if the virtual machine is powered on.


4. Make changes and or additions as needed. Click OK. Select items on the Virtual Machine Properties dialog box, and configure them. Refer to your VirtualCenter and ESX Server documentation for comprehensive information about configuring virtual machines.
### 14.2.1 Changing the Hardware Configuration of a Virtual Machine

You can virtually manage all the hardware in the virtual machine, configuring additional virtual hardware as needed. Below is a list of the virtual hardware devices that can be added, disabled or reconfigured:

- DVD/CD-ROM Drive Configuration
- Floppy Drive Configuration
- Generic SCSI Device Configuration
- Virtual Disk Configuration
- Memory Configuration
- Virtual Ethernet Adapter (NIC)
- Parallel Port Configuration
- SCSI Controller Configuration
- Serial Port Configuration
- Video Configuration
- Virtual CPU Configuration
- Audio Configuration
- Mouse Configuration

### 14.2.2 Adding Hardware to a Virtual Machine

You add virtual hardware to a virtual machine using the Add Hardware Wizard. To start the wizard:

1. From the VirtualCenter client, select the virtual machine.
2. Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
4. Click the **Hardware** tab.
5. Start the **Add Hardware** Wizard. Click **Add**.

Follow the steps in the wizard. You can select to add the following virtual hardware to an existing virtual machine:

- DVD/CD-ROM Drive
- Floppy Drive
- Generic SCSI Device
- Hard Disk
- Ethernet Adapter (NIC)
- Parallel Port
- Serial Port
- Virtual Sound Adapter
14.2.3 Changing Virtual Machine Options

The virtual machine settings allow you define actions that occur in various virtual machine power states.

Changing General Settings

1. From the VirtualCenter client, select the virtual machine.
2. Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
3. Choose Edit > Properties or click Edit Properties from the Summary tab to display the Virtual Machine Properties dialog box.
4. Click the Options tab to view the general options. Click General in the Settings list.
5. If you want, you can change the name of the virtual machine in the Virtual machine name field. This does not change the name of any virtual machine files or the associated directory.
6. If you are upgrading the guest operating system in the virtual machine, select the new guest operating system. This changes some basic configuration settings to optimize the guest operating system’s performance.
7. Click OK to save your changes. The Virtual Machine Properties dialog box closes.

Changing Power State Options

To change the settings for actions that occur when the power state of a virtual machine changes:

1. From the VirtualCenter client, select the virtual machine.
2. Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
4. Click the Options tab.
5. View the power options. Click Power in the Settings list.
6. The stop button on the toolbar can be configured to power off the virtual machine or shut down the guest operating system. The reset button on the toolbar can be configured to reset the virtual machine or restart the guest operating system. Choose the desired actions in the lists under Power Controls.
7. You can configure VMware Tools scripts to run automatically when you change the virtual machine’s power state by checking the appropriate options under Run VMware Tools scripts.
8. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
Changing Virtual Machine Resource Settings

You can manually change individual resource settings or you can schedule to have the priority for resources changed. The Virtual Machine Properties dialog box provides a means to adjust the host resource allocation for the selected virtual machine.

Each of the following sections describes adjusting the allocations or priorities of the referenced resource:

- **Scheduling a Resource Settings Change** – From here you can use the scheduler to automatically change the CPU and memory resource allocation for a virtual machine during certain times when greater resources are needed.

- **Changing CPU Settings** – These settings allow you to set minimum and maximum processor resources available to the virtual machine. The range allows for 100 points per processor available, so 30 would be 30% of a single processor and 200 would enable full use of dual processors. Shares represent a relative metric for allocating processor capacity between virtual machines. Scheduling affinity allows you to bind a virtual machine to a specific processor.

- **Changing Memory Settings** – These settings allow you to set minimum, maximum and relative memory allocation for a virtual machine. Minimum represents the minimum amount of memory that must be available in order to power on the virtual machine. Maximum represents the amount of memory allocated to the virtual machine when it was configured. Shares represent a relative metric for allocating memory to all virtual machines. Symbolic values Low, Normal, and High are compared to the sum of all shares of all virtual machines on the server and the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.
**Changing Disk Settings** – These settings allow you to change the resource allocations for the disk of a virtual machine. Select the datastore, then allocate a number of shares of its disk bandwidth to the virtual machine. A share is a value that represents the relative metric for controlling disk bandwidth to all virtual machines. The values Low, Normal, and High are compared to the sum of all shares of all virtual machines on the server and the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.

**Changing Network Settings** – These settings allow you to change the parameters of network traffic shaping. To enable traffic shaping, check Enable Traffic Shaping and then define network traffic parameters. You can select to specify the Average Bandwidth, the Peak Bandwidth and the Burst Size in either Megabits per second (Mbps), Kilobits per second (Kbps), or bits per second (bps).
14.3 Scheduling Tasks

You can create scheduled tasks to automatically perform operations at specified times and configure the tasks to occur once or routinely. You can apply tasks to groups, farms, or individual virtual machines. The Scheduled Tasks panel lists all planned for and user-defined actions within the VirtualCenter environment. You can create, modify, or remove tasks, as needed.

Create a scheduled task through the New Task Wizard, which displays the available task options such as:
- Deploy a virtual machine from a template
- Clone an existing virtual machine
- Change the power state of a virtual machine
- Migrate a virtual machine
- Migrate a virtual machine with VMotion
- Change resource settings of a virtual machine

After you select an option, the wizard displays the screens that are relevant to the type of task you are scheduling. The New Task Wizard ends when you set the timing of the task. You can reschedule tasks.

If the directions of manually driven and scheduled activities conflict, VirtualCenter performs whichever activity is due first. If a virtual machine is in an incorrect state to perform any activity, manual or scheduled, VirtualCenter sends a message to the log and does not perform the task.

When you create a scheduled task, VirtualCenter verifies that you have the correct permissions to perform the actions on the relevant farms, hosts, and virtual machines. Once the task is created, the task is performed even if you no longer have permission to perform the task.

When an object is removed from VirtualCenter, all associated tasks are also removed. Events are logged to the event log at start and completion of the tasks. Any errors that occur during the task are also recorded in the event log.

Perform the following steps to schedule a task for a virtual machine. This example shuts down a server at 2am daily for a full backup and a second scheduled task can restart the server after the backup window has passed.

1. Choose File > New > Scheduled Task from the VirtualCenter client menu.
2. Confirm continuing with the New Task Wizard. Click Next.
3. Select to Change the power status of a virtual machine. Click Next.
4. Select the Power Operation **Shutdown** from the options. Click **Next**.

5. Choose which virtual machine the scheduled task applies to. Click **Next**.

6. Choose the time when this task will run. This task can either run once or recur at regular intervals. Select a **Daily** interval at **2:00 am**. Click **Next**.

7. Click **Finish** to complete the New Task Wizard. You can optionally select to receive an email when this task completes. To complete this example, you can create a second scheduled task that **Powers on** the virtual machine every day at **2:30 am** once the backup is complete.
14.4 Using Events & Alarms

An event is any action that is of interest to VirtualCenter. Each event triggers an event message that is logged in the VirtualCenter database. You can view event messages from two locations:

- The **Events** option in the navigation bar displays all events that have occurred on the VirtualCenter server.
- An **Events tab** for any object under the Inventory button. These Events tab listings show only the events that occurred on or to the selected farm, host, or virtual machine.

The most recent events appear at the end of a scrollable list. Messages are identified by type:

- Information
- Error
- Warning

Messages are also color-coded. A shortened event message appears in the description portion of the panel. A more detailed version of a selected event message appears in the Event Details portion of the panel. Typically, the Event Detail entry indicates the host or virtual machine on which the event occurred and describes the action that occurred. The object of the event is a link to the object’s individual event page.

VirtualCenter allows you to sort and filter VirtualCenter events using the text search string field in the upper right corner of the Events tab. You can also export events using the **File > Export Events** option in the VirtualCenter menu.

Alarms are preconfigured actions that can be triggered when selected events occur. You can apply alarms to any VirtualCenter object and view, modify, and remove an existing alarm through the Alarms tab of the object where the alarm was defined. The screenshot below displays the default alarms created for each ESX Server host.

You can create additional alarms by right clicking on the target host or virtual machine and selecting **New Alarm**. The available triggers monitor CPU usage, memory usage, heartbeat and state and track them within thresholds that categorize them as Green, Yellow or Red. When a trigger changes from one color to another, you can select to automate an action such as sending an email, sending a notification trap, running a script and suspending / powering off / resetting the virtual machine.
Configuring an ESX VIN to use a Storage Area Network

Up until now, all evaluation activities have used the local VMFS storage on the ESX Server. This next chapter will walk you through setting up your ESX Server to store and run virtual machines from a LUN on a shared storage area network. ESX Server supports QLogic and Emulex HBAs (host bus adapters), which allow an ESX Server computer to be connected to a SAN and to see the available disk arrays. These steps assume you have a supported storage system, a supported Fibre Channel switch, and that there is at least one Fibre Channel HBA in each server. If you don't have sufficient hardware available, you can still read through this section to gain an understanding of how SANs are used by the virtual infrastructure.

Use the Storage Management option in the ESX Server MUI to manage your storage area network and attached storage devices for your ESX Server system and its virtual machines. Because multiple ESX Servers can potentially access the disks on the SANs concurrently, there are some configuration issues that are unique to SANs. The SCSI configuration information contained in this section also applies to Fibre Channel adapters, but note that FC adapters may require additional configuration as well. For information on supported SAN hardware, download the VMware ESX Server SAN Compatibility List from the VMware Web site at http://www.vmware.com/support/resources/esx_resources.html.

Understanding Storage Arrays

Large storage systems (also known as disk arrays) combine numerous disks into arrays for availability and performance. Typically, a collection of disks is grouped into a Redundant Array of Inexpensive Disks (RAID) array to protect the data by eliminating disk drives as a potential single point of failure. Disk arrays carve the storage RAID set into logical units (LUNs) that are presented to the server in a manner similar to an independent single disk. Typically, LUNs are few in number, relatively large, and fixed in size. You can create LUNs with the storage management application of your disk array.

ESX Server can Run Virtual Machines from SANs and Optionally Boot from SANs

With ESX Server 2.5, you can install the system on a SAN versus local disks and boot from the SAN. This optional runtime configuration is ideal for diskless blade servers and is further described in the VMware SAN Configuration Guide. If you are not installing ESX Server so that it can be booted from a SAN, we recommend that all Fibre Channel adapters be dedicated exclusively for the virtual machines.

Confirm that your HBA is assigned only to virtual machines and not shared with the Service Console. This was a configuration option during resource allocation in the ESX Server installation. Right-click on the ESX Server Host in VirtualCenter and select to Edit Configuration. This will open the VMware Management Interface for the ESX Server.

Select the Options tab and open the Startup Profile dialog. Scroll down to your fiber storage controller group and ensure that the controller is not Shared with Service Console. If it is, deselect the option, apply the change, and reboot the system to implement the change.

Fibre storage controller group: qla2300_607.0
Dedicated To
Driver
QLA2300_607.0
Emulex Corp QLA2300 v2.240 (rev 02) (7/14/06)
Shared with Service Console
Configure VMkernel Options for Your SAN (Advanced Settings)

When you install the VMware ESX Server, various system parameters are assigned predetermined values. These parameters control settings for memory, the processor and networking, for example, and affect the running of virtual machines. You can view these settings from the ESX Server management interface. In order to use all storage devices on your SAN, you may need to change some VMkernel configuration options as described below. Caution: You should not make any changes to these settings unless you are working with the VMware support team or otherwise have thorough information about what values you should provide for them. Some configuration settings shown on this page are described in the ESX Server manual and may be changed as described in the manual. In most cases, however, you should not modify these settings unless this evaluation guide or a VMware technical support engineer suggests that you do so.

To make these changes, complete the following steps.

1. Log in to the VMware Management Interface as root. The Status Monitor page appears. Note that you must be logged into the ESX Server as root for the Options tab to be available.

2. Click the Options tab and the Advanced Settings option.

3. In general, to change the setting for a VMkernel configuration parameter, click the link for the value. The Update VMkernel Parameter window opens on top of the VMware Management Interface window. In the Value entry field, type the value for the parameter and click OK. The window closes and the updated parameter appears on the Advanced Settings page.

4. By default, the VMkernel scans for only LUN 0 to LUN 7 for every target. If you are using LUN numbers larger than 7 you must change the setting for the DiskMaxLUN field from the default of 8 to the value that you need. For example, if you now have LUN numbers 0 to 27 active, set this option to 28. Currently, an ESX Server machine can see a maximum of 128 LUNs over all disk arrays on a SAN.

5. By default, the VMkernel is configured to support sparse LUNs — that is, a case where some LUNs in the range 0 to N-1 are not present, but LUN N is present. Confirm that the DiskSupportSparseLUN field is set to 1. This increases the time needed to scan for LUNs but enables the ESX Server to find sparse LUNs.

6. The DiskMaskLUNs configuration option allows the masking of specific LUNs on specific HBAs. Masked LUNs are not touched or accessible by the VMkernel, even during initial scanning. This option takes a string comprised of the adapter name, target ID and comma-separated range list of LUNs to mask. The format is as follows:
   
   `<adapter>:<target>:<comma_separated_LUN_range_list>);

   For example, if you want to mask LUNs 0-20 and 27-255 on vmhba1 target 0. To accomplish this, set the DiskMaskLUNs option to the following: `vmhba1:0:0-20,27-255;`

   Note that LUN 0 cannot be masked. The DiskMaskLUNs option overrides the DiskMaxLUN option for adapters that have a LUN mask. In other words, continuing the preceding example, there are four adapters, vmhba0, vmhba1, vmhba2, and vmhba3, and the DiskMaxLUN option is set to 28. In this example, vmhba0, vmhba2 and vmhba3 only scan LUNs 0-27, but vmhba1 scans all LUNs that are not masked, up to LUN 255, or the maximum LUN setting reported by the adapter, whichever is less. For administrative or security purposes, you can use LUN masking to prevent the server from seeing LUNs that it doesn’t need to access. Refer to your documentation on disk arrays for more information.
In summary, to use the most open configuration that should display all available LUNs, set the `DiskSupportSparseLUN` to 1, set the `DiskMaxLUN` to 255 or as high as your SAN is configured to support, and leave the `DiskMaskLUNs` to an empty string to disable LUN masking.

**Scan for Devices and LUNs Available to ESX Server**

Next, you can manually initiate a scan through the VMware Management Interface by selecting to Rescan SAN from the Storage Management window. ESX Server scans for devices, and LUNs on these devices, whenever a Fibre Channel driver is loaded. You may want to rescan devices or LUNs whenever you add a new disk array to the SAN, create new LUNs on a disk array, or change the LUN masking on a disk array. You can also use the `cos-rescan.sh` command simply by entering the command at a shell prompt.

**Create a Disk Partition on the Target LUN**

The Disks and LUNS window allows you to view and modify the partitions and file systems on your disks. You can create disk partitions that use the VMFS file system, suitable for storing disks for virtual machines. You can also edit, label and remove existing partitions. When you edit a VMFS partition, you can change the volume label, maximum file size, access mode and whether you want to span the partition across multiple LUNs. You can use any existing free space on your VMFS volumes to create new disk partitions. Note that you cannot change any partitions set up when you installed ESX Server. These include any volumes with a Linux file system or that are used for Linux swap space. Be sure that only one ESX Server system has access to the SAN while you are using the VMware Management Interface to configure the SAN and format the VMFS-2 volumes.

To create a new VMFS-2 partition for hosting virtual machines, complete the following steps.

1. In the Disks and LUNs window, click Create Volume to the right of the unpartitioned disk.

2. You are asked how you prefer to configure the disk. Click Typical.
3. Next enter a unique label for the new VMFS volume. Click **OK** to create the volume.

4. After you create the partition, you will see it in the list of volumes available to the ESX Server. To edit an existing disk partition, select the partition and click **Edit**.

5. The Edit Volume window appears, allowing you to edit the volume label, change the access mode, set the maximum file size and span the disk with any public extents. After you have finished the configuration, be sure that all partitions on the physically shared SAN disk are set for public or shared access for access by multiple ESX Server systems. There are two modes for accessing VMFS volumes: public and shared.

   - **Public** — This is the default and recommended mode for ESX Server. With public VMFS version 2 (VMFS-2) volumes, multiple ESX Server computers and their hosted virtual machines can access the VMware ESX Server file system concurrently. VMware ESX Server file systems with a public mode have automatic locking to ensure file system consistency.

   - **Shared** — Used for a VMFS volume that is used for failover-based clustering among virtual machines on the same or different ESX Servers. For more information on clustering with ESX Server, see Configuration for Clustering in the ESX Administrator’s Guide.
Troubleshooting SAN Issues with ESX Server

You can view LUNs through the VMware Management Interface or viewing the output of `ls /proc/vmware/scsi/<FC_SCSI_adapter>` from the Service Console. If the output differs from what you expect, then check the following:

1. **DiskMaxLUN** — The maximum number of LUNs per vmhba that are scanned by ESX Server. You can view and set this option through the VMware Management Interface (Advanced Settings in the Options page) or by viewing this setting through `/proc/vmware/config/Disk` in the Service Console.

2. **DiskSupportSparseLUN** — If this option is on, then ESX Server scans past any missing LUNs. If this option is off, ESX Server stops scanning for LUNs if any LUN is missing. You can view and set this option through the VMware Management Interface (Advanced Settings in the Options page) or by viewing this setting through `/proc/vmware/config/Disk` in the Service Console.

3. **LUN masking** — With LUN masking, each LUN is exclusively assigned and accessed by a specific list of connections. Be sure that LUN masking is implemented properly and that the LUNs are visible to the HBAs on ESX Server.

4. **Zoning** — Zoning limits access to specific storage devices and increases security and decreases traffic over the network. If you use zoning, be sure that zoning on the SAN switch is set up properly and that all vmhba and the controllers of the disk array are in the same zone.

5. **Storage controller** — If a disk array has more than one storage controller, then make sure that the SAN switch has a connection to the controller that owns the LUNs you wish to access. On some disk arrays, only one controller is "active" and the other controller is "passive" until there is a failure. If you are connected to the wrong controller, then you may not see the expected LUNs, or you may see the LUNs, but may get errors when trying to access them.

Once you have successfully configured the ESX Server for access to shared LUNs on the SAN, these additional datastores will show up along with available local disks in the Datastores section of the Summary tab for the selected host server within the VirtualCenter client. You can create new virtual machines, deploy virtual machines from templates and clone existing virtual machines onto these new SAN datastores just as though they were local SCSI disks.
16 Migrating Virtual Machines across ESX Servers

Migration is the act of moving a virtual machine from one managed host to another. Note that in order to demonstrate migration of virtual machines across ESX Servers, you will need to repeat the steps in Chapter 10 to install a second ESX Server and Chapter 15 to configure its access to shared SAN LUNs. If you don’t have sufficient hardware to setup a second server, you can still read through this section to gain an understanding of how virtual machines can be dynamically and seamlessly relocated within the virtual infrastructure.

‘Cold’ Migration — Moving a powered off virtual machine between managed hosts on a farm. The figure to the left illustrates the process for migrating a powered off virtual machine from one managed host to another. Note that cold migration of virtual machines can occur between ESX Servers and GSX Servers and does not require the server hosts to share a SAN.

‘Hot’ Migration with VMotion — Moving a powered on virtual machine between managed hosts in a server farm. Moving a powered-on virtual machine allows the virtual machine to continue performing transactions without interruption. This function requires activation of VMotion on both the source and target host. The figure to the left illustrates migrating a powered on virtual machine from one managed host to another using VMotion.

VirtualCenter’s Migration Wizard will automatically perform a cold migration on the selected virtual machine if it is powered off, and a hot migration on the selected virtual machine if it is powered on and VMotion is enabled.
16.1 Migrate a Powered-Off Virtual Machine to another Host using the SAN

Once you have successfully configured access to the Storage Area Network on the ESX Server, you can now host virtual machines on the ESX Server that utilize the SAN server rather than the local SCSI disk for storage. Running virtual machines from shared SAN storage enables VMotion hot migrations and greatly increases data center flexibility and fault tolerance.

At this point, you can choose to create a new virtual machine on the SAN, deploy an existing template to the SAN, clone an existing virtual machine to the SAN or cold migrate an existing virtual machine to the SAN. The only step different in placing a virtual machine on the SAN is to select to deploy the virtual machine to the SAN rather than to a local VMFS partition when prompted. As cold migration is the only option not yet demonstrated, use cold migration to move a virtual machine to a different ESX Server while moving the virtual machine storage from local disk to shared SAN storage.

Perform the following steps to migrate a powered-off virtual machine from the local disk of one ESX Server to the shared SAN storage of another ESX Server:

1. From the VirtualCenter client, view the inventory panel to display the available virtual machines. Shutdown the virtual machine if it is running. Right-click on the desired virtual machine and select the Migrate option to start the Migration Wizard. Confirm the Migration Wizard. Click Next.

2. Select the target destination host for the virtual machine. Click Next.

3. Select the shared LUN datastore for the virtual machine rather than a local SCSI disk. Click Next.

4. Complete the wizard. Click Finish. VirtualCenter moves the virtual machine and virtual disks to the new ESX Server host and datastore location. Event messages appear in the Events tab. The data displayed on the Summary and Tasks tab shows the status and state throughout the migration.
16.2 Migrate a Powered-On Virtual Machine to another Host using the SAN (VMotion)

VMotion allows working processes to continue throughout a migration with VMotion. The entire state of the virtual machine as well as its configuration file is moved to the new host even while the data storage remains in the same location on the SAN. The associated virtual disk remains in the same location on the SAN storage that is shared between the two hosts. Once the configuration file is migrated to the alternate host, the virtual machine is then run on the new host.

The state information includes the current memory content and all the information that defines and identifies the virtual machine. The memory content includes transaction data and whatever bits of the operating system and applications are in the memory. The defining and identification information stored in the state includes all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses for the Ethernet cards, chip set states, registers, and so forth. Migration with VMotion happens in three stages:

1. When the migration with VMotion is requested, VirtualCenter verifies that the existing virtual machine is in a stable state with its current host.
2. The virtual machine state information, that is, memory, registers, network connections, is copied to the target host.
3. The virtual machine resumes its activities on the new host.

Understanding VMotion Requirements

The ESX Server hosts you are planning to migrate between must meet the following requirements:

- **Shared SAN** - The source and target hosts must share a SAN with a public mode VMFS partition that contains the virtual machine to be migrated. Ensure that all VMFS volumes on your managed hosts use volume names, and that the virtual machines use the volume names for specifying the virtual disks.

- **Compatible Processors** - Ensure that the source and destination hosts have a compatible set of processors. Since VMotion transfers the running architectural state of a virtual machine between underlying VMware ESX Servers, VMotion compatibility means that the CPUs of the target host must be able to resume execution using the equivalent instructions where the CPUs of source host were suspended. CPU clock speeds and cache sizes may vary, but in order for two processors to be compatible for migration with VMotion, they must satisfy the following constraints:
  - Same vendor class (Intel vs. AMD)
  - Same processor family (Processor families such as Xeon MP and Opteron are defined by the CPU vendors, and different versions within the same processor family can be distinguished by comparing a CPU’s model, stepping level, and extended features. In most cases different CPU versions within the same family are similar enough to maintain compatibility.)

- **Local Virtual Machine Configuration File** - The virtual machine configuration file should not reside on a VMFS located on the shared datastore.

- **No Clustered Applications, Raw or Undoable Disks** - VMotion does not currently support the migration of clustered applications or raw or undoable virtual disks. If you have clustered applications or raw or undoable disks, store the disks on separate VMFS volumes from the virtual machines you plan to migrate using VMotion.

- **Dedicated Gigabit Ethernet Network** - VMotion requires the setup of a private, Gigabit Ethernet migration network between all of the VMotion-enabled managed hosts. When VMotion is enabled on a managed host, configure a unique network identity object for the managed host and connect it to the private migration network.

Provided you have a shared SAN with compatible server processors and the dedicated Ethernet Network, the configuration described in this evaluation guide should ensure these requirements are met.
Enabling VMotion for an ESX Server Host

You must enable VMotion on both the target and the source host to support migration with VMotion.

To enable a host for VMotion:

1. The host needs to have the evaluation VMotion licenses entered. This was likely performed when VirtualCenter was installed and the license key file was created and entered.

2. From the VirtualCenter client, display the inventory panel to view the host.

3. Click the Inventory option in the navigation bar. Expand the inventory as needed, right-click the desired host and select Properties to display the Host Properties dialog box.

4. To enable VMotion, select the VMotion tab and click Yes. The remainder of this configuration is the information for the VMotion migration network, including which NIC it uses, and its IP address and gateway. The migration network is preferably its own separate network. Select the Network Label, which is likely VMotion if that was what you labeled the virtual switch during the virtual machine's configuration. Enter any IP Address that should be valid and available on the migration network connecting the ESX Server hosts. In the Gateway address field, you would typically enter the static IP address of a network gateway. For this example deployment, you can duplicate the VMotion IP address in the Gateway field. Click OK.
Moving Powered-On Virtual Machines with VMotion

To demonstrate the seamless server-to-server migration of a running virtual machine, you can select to have any type of applications running on the virtual machine from a database server to a video client. In this example, a video is streaming from the Internet to a local browser on the server and you can watch the video consistently on the console even as the hardware is exchanged out from under the virtual machine.

To manually migrate a powered-on virtual machine:

1. Disconnect any remote consoles that are external to VirtualCenter and connected to the virtual machine you are migrating. The migration will not complete until external remote consoles are disconnected. Also, disconnect any peripheral devices connected to the virtual machine.

2. From the VirtualCenter client, display the inventory panel to view the virtual machine. Click the Inventory option in the navigation bar. Expand the inventory as needed, and select the virtual machine to move.

3. View the Summary tab of both the source and target ESX Server hosts to ensure that they are VMotion-enabled and using the same SAN. Check the VMotion Enabled field and the Datastores section. The VMotion Enabled field should say Yes. Datastores on both hosts should list the same shared datastore that contains the virtual machine to migrate.

4. Click on the Console tab to view the desktop and confirm that the virtual machine is running. Select to start the virtual machine if it is not running. Right-click on the desired virtual machine and select Migrate to start the Migration Wizard.
5. Alternately, you can drag and drop the virtual machine on to the target host to start the Migration Wizard. Confirm the Migration Wizard. Click **Next**.

5. If you did not use drag and drop to identify the destination host in advance, the Destination Host window will appear next. Select the target destination host for the virtual machine. Click **Next**.

6. Select the migration priority level. Set the priority of the migration to ensure that sufficient CPU resources are available on both the source and target hosts to perform the migration. Click the appropriate button and click **Next**.

7. Confirm the migration with VMotion Wizard. Click **Finish**. VirtualCenter moves the selected virtual machine from the original host to the target host. The virtual disks remain in the same location on the shared datastore, the IP address of the virtual machine remains the same, but the virtual machine is now hosted on a different server.
17 Application Functional Testing & Load Testing

With an ESX Server Virtual Infrastructure Node installed and being managed by VirtualCenter, your evaluation at this point is self-directed. You could, for example, recreate some of the production systems in your IT infrastructure onto one box to test their relative performance individually and under consolidated load.

With any of these virtual machines, you can click through the full menu structure of VirtualCenter and test out the other configuration properties and actions available. Keep in mind that you can refer to the full user's guides for ESX Server and VirtualCenter for more information or to support evaluation steps not addressed in this guide.

Recall that virtual machines for evaluation can be created from scratch, cloned from existing physical servers using the P2V Assistant, and installed from templates available from 3rd party vendors through the VMTN program.

18 Summary

VMware is the market leader in datacenter server virtualization for the x86 platform. ESX Server is the VMware flagship virtualization platform software for partitioning and consolidating systems in the most demanding environments. ESX Server is industry proven, well ahead of any other virtual machine software in providing high performance, scalability, availability, manageability, and support. ESX Server provides robust resource management, allowing workloads to be dynamically reconfigured based on business needs. ESX Server is proven to reduce hardware and operational costs while greatly reducing the time required to provision and deploy new servers.

<table>
<thead>
<tr>
<th>Key Task</th>
<th>Traditional Approach</th>
<th>VirtualCenter Approach</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provision a New Server</td>
<td>3 - 10 days hardware procurement 1 - 4 hours provisioning new server</td>
<td>5 - 10 minutes provisioning new VM</td>
</tr>
<tr>
<td>Hardware Maintenance</td>
<td>Requires 1 - 3 hour maint. window Requires days/weeks of change management preparation</td>
<td>Zero Downtime Maintenance with VMotion</td>
</tr>
<tr>
<td>Moving Servers to</td>
<td>Requires days/weeks of change management preparation 4 - 6 hours for migration with service interrupted during the maintenance window</td>
<td>1 hour migration with P2V 2 - 5 minutes using VMotion™ (no service interruption)</td>
</tr>
<tr>
<td>Consolidate / Optimize</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optimize Workloads</td>
<td>40+ Hours for Physical to Physical Recovery</td>
<td>&lt; 4 Hours for Virtual to Virtual Recovery</td>
</tr>
<tr>
<td>Recover from Disaster</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VirtualCenter provides your entire IT administrative team with one place to determine the status of your virtual infrastructure and the overall system utilization of your computing resources. It gives users the tools they need to analyze and better determine which virtual machines require resource adjustments, so they will perform optimally. This product provides IT staffs with tremendous flexibility in managing and consolidating application workloads. VirtualCenter is a necessity for managing virtual infrastructure and a key building block to enable utility computing.
19 Glossary

Alarms — An entity that monitors one or more properties of a virtual machine, such as CPU load. Alarms use green, red, and yellow color-coding issue notifications as directed by the configurable alarm definition.

Allocated disk — A type of virtual disk where all disk space for the virtual machine is allocated at the time the disk is created. This is the default type of virtual disk created by VirtualCenter. The alternative to an allocated disk is a raw disk.

Clone — The process of making a copy of a virtual machine. This process includes the option to customize the guest operating system of the new virtual machine. When a clone is created VirtualCenter provides an option to customize the guest operating system of that virtual machine. Clones can be stored on any host within the same farm as the original virtual machine.

Configuration — See Virtual machine configuration file.

Console — See VMware Virtual Machine Console.

Custom networking — Any type of network connection between virtual machines and the host that does not use the default bridged, host-only or network address translation (NAT) networking configurations. For instance, different virtual machines can be connected to the host by separate networks or connected to each other and not to the host. Any network topology is possible.

Customization — The process of customizing a guest operating system in a virtual machine as it is being either deployed from a template or cloned from another existing virtual machine. Customization options include changing the new virtual machine identification and network information.

Datastore — The storage locations for the virtual machine files.

Drag and drop — A feature of VMware VirtualCenter that allows you to move virtual machines easily between groups.

Events — A message record of VirtualCenter activities. Through the Navigation option all the events are displayed. Through an object specific panel, only events relative to that object are displayed.

Farm — A required structure under which hosts and their associated virtual machines are added to the VirtualCenter server. VirtualCenter server supports multiple farms. A host can be managed only under one farm.

Farm groups — An optional grouping structure, it is contained within the Server Farms structure. The VirtualCenter server supports multiple farm groups. Farm groups can contain other farm groups and farms.

Guest operating system — An operating system that runs inside a virtual machine.

Headless — A program or application that runs in the background without any interface connected to it. A running virtual machine that has no consoles connected to it is running headless.

Host — The physical computer on which the VirtualCenter virtual machines are installed.

Host-only networking — A type of network connection between a virtual machine and the host. Under host-only networking, a virtual machine is connected to the host on a private network, which normally is not visible outside the host. Multiple virtual machines configured with host-only networking on the same host are on the same network.

Inventory — Provides a view of all the monitored objects in VirtualCenter. Monitored objects include: Server Farms, farms, farm groups, hosts, virtual machines, and virtual machine groups.

Migration — Cold migration moves a powered off virtual machine between hosts. Hot migration (VMotion) moves a powered on virtual machine between hosts.

Migration with VMotion — Moving a virtual machine that is powered on and has met selected requirements,
including the activation of VMotion on both the source and target host. When a migration with VMotion is performed, the operations of the virtual machine can continue without interruption.

**New Virtual Machine Wizard** — A point-and-click interface for convenient, easy creation of a virtual machine configuration. It prompts you for information, suggesting default values in most cases. It creates files that define the virtual machine, including a virtual machine configuration file and (optionally) a virtual disk or raw disk file.

**Nonpersistent disk mode** — If you configure a virtual disk as an independent disk in nonpersistent mode, all disk writes issued by software running inside a virtual machine with a disk in nonpersistent mode appear to be written to disk but are in fact discarded after the virtual machine is powered off. As a result, a virtual disk or raw disk in independent-nonpersistent mode is not modified by VirtualCenter.

**Persistent disk mode** — If you configure a virtual disk as an independent disk in persistent mode, all disk writes issued by software running inside a virtual machine are immediately and permanently written to a virtual disk in persistent mode. As a result, a virtual disk or raw disk in independent-persistent mode behaves like a conventional disk drive on a physical computer.

**Raw disk** — A hard disk in a virtual machine that is mapped to a physical disk drive or partition on the host machine. A virtual machine’s disk can be stored as a file on the host file system (see Virtual disk) or on a local hard disk. When a virtual machine is configured to use a raw disk, VirtualCenter directly accesses the local disk or partition as a raw device (not as a file on a file system). It is possible to boot a previously installed operating system on an existing partition within a virtual machine environment. The only limitation is that the existing partition must reside on a local IDE or SCSI drive.

**Read Only User** — A role where the user is allowed to view the inventory but not allowed to perform any tasks.

**Redo log** — The file that stores the changes made to a disk in undoable or nonpersistent mode. You can permanently apply the changes saved in the redo log to a disk in undoable mode so they become part of the main disk files. For a disk in nonpersistent mode, however, the redo-log file is deleted when you power off or reset the virtual machine without writing any changes to the disk.

**Resume** — Return a virtual machine to operation from its suspended state. When you resume a suspended virtual machine, all applications are in the same state they were when the virtual machine was suspended.

**Role** — A VirtualCenter pre-defined set of access rights and privileges. There are four roles; each subsequent role includes the privileges of the lesser role.

**Scheduled Tasks** — A VirtualCenter activity that is configured to occur at designated times. The Tasks panel displays a list of and a means to schedule selected activities.

**Server Farms** — The top-level structure for the VirtualCenter server. There is only one Server Farms per VirtualCenter server.

**Supported partition** — A virtual disk partition that VMware Tools can prepare for shrinking, such as one of the drives that comprise the virtual hard disk. You can choose to not prepare certain partitions for shrinking.

**Suspend** — Save the current state of a running virtual machine. To return a suspended virtual machine to operation, use the resume feature.

**Template** — A golden image of a virtual machine. This typically includes a specified operating system and configuration that provides virtual counterparts to hardware components. Optionally, a template can include an installed guest operating system and a set of applications. Templates are used by VirtualCenter to create new virtual machines.

**Template upload directory** — A template upload directory is located on the VirtualCenter server machine. A copy of the original virtual machine virtual disks is placed in the directory you specify as the template upload directory. This is typically used for creating templates from non-ESX Server or GSX Server virtual machines that are stored locally to the VirtualCenter server.
Templates — Provides a list of and a means to import virtual machines and store them as templates for deploying at a later time to create new virtual machines.

Undoable disk mode — If you configure a virtual disk as an independent disk in undoable mode, all disk writes issued by software running inside a virtual machine with a disk in undoable mode appear to be written to disk but are in fact written to a redo log that can later be committed or discarded. Undoable disk mode allows optional data commits, whereas Nonpersistent disk mode always discards changes when the virtual machine is restarted. Undoable and Nonpersistent disk access modes are especially useful in development, testing and training environments.

 Unsupported partition — A virtual disk partition that VMware Tools cannot prepare for shrinking. Unsupported partitions include read-only drive partitions, partitions on remote devices and partitions on removable devices such as floppy drives or CD-ROM drives.

Virtual disk — A virtual disk is a file or set of files that appear as a physical disk drive to a guest operating system. These files can be on the host machine or on a remote file system. When you configure a virtual machine with a virtual disk, you can install a new operating system into the disk file.

Virtual machine — A virtualized x86 PC environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same host machine concurrently.

Virtual Machine Administrator — A role where the user is allowed to perform all the virtual machine management functions.

Virtual machine configuration — The specification of what virtual devices (disks, memory size, etc.) are present in a virtual machine and how they are mapped to host files and devices.

Virtual machine configuration file — A file containing a virtual machine configuration. It is created by the New Virtual Machine Wizard. It is used by VirtualCenter to identify and run a specific virtual machine.

Virtual Machine Properties — A point-and-click control panel used to view and modify the resource settings of all the virtual machines on a host.

Virtual Machine Groups — An optional grouping structure, it is subset to a farm. VirtualCenter server supports multiple virtual machine groups. Virtual machine groups contain virtual machines and other virtual machine groups.

Virtual Machine User — A role where the user is allowed to perform power operations on virtual machines.

VirtualCenter Administrator — A role where the user is allowed to set the user+role permissions and controls the VirtualCenter licensing.

VirtualCenter Client — A user interface that runs locally on a Windows machine. The VirtualCenter client runs on a networked machine. This can be on the same machine as the VirtualCenter server or another networked machine. The VirtualCenter client requires a monitor for access to the graphical user interface.

VirtualCenter Database — A persistent storage area, for maintaining status of each virtual machine and user managed in the VirtualCenter environment. This is located on the same machine as the VirtualCenter server.

VirtualCenter Agent — Installed on each virtual machine host, it coordinates the actions received from the VirtualCenter server.

VirtualCenter Server — A service that acts as a central administrator for VMware servers connected on a network, to direct actions upon the virtual machines and the virtual machine hosts. VirtualCenter server is the central working core of VirtualCenter.

VMotion — Enables moving running virtual machines from one ESX Server to another without service interruption. It requires licensing on both the source and target host. This feature is activated by the VirtualCenter agent. The VirtualCenter server centrally coordinates all VMotion activities.
VMware Tools — A suite of utilities and drivers that enhances the performance and functionality of your guest operating system. Key features of VMware Tools include some or all of the following, depending on your guest operating system: an SVGA driver, a mouse driver, the VMware guest operating system service, the VMware Tools control panel and support for such features as shared folders, drag and drop in Windows guests, shrinking virtual disks, time synchronization with the host, VMware Tools scripts and connecting and disconnecting devices while the virtual machine is running.

VMware Virtual Machine Console — Interface to a virtual machine that provides access to one or more virtual machines on the local host or a remote host running VirtualCenter. You can view the virtual machine’s display to run programs within it or modify guest operating system settings. In addition, you can change the virtual machine’s configuration, install the guest operating system or run the virtual machine in full screen mode.

20 VMware Professional Services

VMware professional services can deliver deployment and implementation of key virtual infrastructure services, including customization, rapid cutover and best practices consulting. In addition, VMware has strong partnerships with consulting organizations such as IBM Global Services and HP Services that can also provide consulting services, including server consolidation, deployment, and disaster recovery.

VMware Professional Services include:

Education Services
VMware Education Services provide instructor-led courses on all VMware products— from basic functionality to advanced technical usage. Courses offer extensive hands-on labs, case study examples, and course materials designed for use as on-the-job reference tools.

Consulting Services
For delivery of both VMware custom and pre-packaged solutions, VMware has assembled a team of consulting professionals with an extensive knowledge of the entire VMware product family, advanced expertise in technical and systems management architectures, and strong project management discipline.

Professional Certification
The VMware Certified Professional Program offers technology professionals the knowledge, skills, and credentials to deploy and maintain VMware virtualization technology. This program is designed for any technical individual—partners, end users, resellers, and consultants.

21 VMware Support Services

VMware has designed a suite of support offerings mapped to the unique needs of our customers, ranging from simple Web-based self-service to 24/7 coverage provided by highly trained support engineers.

Customer support is a vital part of the total VMware customer experience. We want customers to get the most from our products long after the initial sale and installation. We are dedicated to ensuring that any issues are resolved satisfactorily. We recognize the need for a broad and flexible range of support options that meet the diverse needs of our customers—whether it is a single-user implementation of VMware Workstation or a complex multiplatform implementation of GSX Server and ESX Server.

For more information about VMware support offerings, please see the VMware Support Web site at http://www.vmware.com/support.
22 VMware Partner Alliance

VMware has established a global network of best-of-breed technology and distribution partners to expand and promote the market for compute virtualization. Our value to mutual customers is simple. Together, we deliver solutions that help businesses grow and innovate, while simplifying computing infrastructure and minimizing total cost of ownership (TCO). When organizations combine VMware software solutions with those of our global partners, they can get the most comprehensive virtual infrastructure solutions and services on the market.

Hardware Alliance Partners

Software Alliance Partners
23 About VMware

VMware, an EMC company (NYSE: EMC), is the global leader in virtual infrastructure software for industry-standard systems. The world’s largest companies use VMware solutions to simplify their IT, fully leverage their existing computing investments and respond faster to changing business demands. VMware is based in Palo Alto, California.

© 2005 VMware. All rights reserved.

Next Steps

If you would like to purchase, evaluate or get more information about VMware VirtualCenter, ESX Server or P2V Assistant, VMware has a global network of solutions providers who are ready to help you.

If you'd like to contact VMware directly, you can reach a sales representative at 1-877-4VMWARE (650-475-5000 outside North America) or email sales@vmware.com. When emailing, please include the state, country and company name from which you are inquiring.

You can also visit our online store at http://www.vmware.com/vmwarestore/.